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CHÈN HÌNH ẢNH VÀ THAY MÀU CHỮ TRÊN NỀN CỦA FOLDER TRONG 
WINXP. 

  
 

  
Nếu bạn ñã từng dùng Win98-Me, thì chắc bạn sẽ rất có ấn tượng với tính năng cho phép chèn ảnh và thay ñổi 
màu sắc font chữ trên nền của folder , nhưng tiếc là trong WinXp bác Bill lại không hỗ trợ tính năng này, nhưng 
có một cách ñể thực hiện tính năng này, bạn phải tạo một file desktop.ini , bạn có thể tìm thấy nó trong mọi 
folder của Win98- Me, hay có thể tự tạo bằng notepad , mở notepad và ñánh (copy) nguyên văn ñoạn code sau 
: 

 

 
 
[.ShellClassInfo] 
IconFile=%SystemRoot%\system32\SHELL32.dll 
IconIndex=3 
ConfirmFileOp=0 
 
[ExtShellFolderViews] 
{BE098140-A513-11D0-A3A4-00C04FD706EC}={BE098140-A513-11D0-A3A4-00C04FD706EC} 
 
[{BE098140-A513-11D0-A3A4-00C04FD706EC}] 
Attributes=1 
IconArea_Image=E:\Hinh anh\koyoko fukada\ips_fukada_kyoko152.jpg 
IconArea_Text=0x000000FF 
  

• Trong ñó dòng IconArea_Image= bạn ñánh ñường dẫn ñến hình mà bạn muốn nó xuất hiện trong 
folder, bạn nên ñánh ñường dẫn ngắn như tôi thì hơn , và nhớ là ñánh luôn cả ñuôi của nó.  

• Dòng IconArea_Text=0x000000FF qui ñịnh màu font chữ trong folder,trong ví dụ màu chữ của tôi là 
màu ñỏ ,bạn chỉ nên thay ñổi dãy số sau chữ “ x” với các màu :  

o 000000 là màu ñen là màu mặc ñịnh , FFFF00 : màu xanh dương …. Bạn có thể tự tìm thêm.  
• Sau ñó lưu lại file với tên desktop.ini (nhớ .ini là ñuôi file chứ không phải là tên), bây giờ bạn có thể dán 

file này kèm ảnh nền của bạn (ví dụ của tôi là hình ips_fukada_kyoko152.jpg) vào bất kì folder nào mà 
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bạn muốn thay ñổi, thoát ra khỏi folder ấy sau ñó vào lại, và “hãy cảm nhận sự khác biệt” . Theo tôi 
bạn nên ñể ñặt tính ẩn cho file desktop.ini và file ảnh kẻo có kẻ phá hoại.  

Nào các bạn hãy cho bác Bill “Gay” mang dấu ấn của mình ñi nào.  
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CHÈN ÂM THANH VÀO VĂN BẢN WORD 
 
ðôi khi, do yêu cầu công việc, bạn phải chuẩn bị một văn bản có kèm thêm âm thanh (nhạc,lời chú thích...), khi 
ñó bạn sẽ xử lý ra sao ? Có 2 phương pháp giải quyết vấn ñề này, tùy theo từng trường hợp cụ thể mà bạn lựa 
chọn phương pháp thích hợp (áp dụng cho Word XP). 

• Phương pháp 1 : Dùng công cụ Sound trong Web Tools 
o Áp dụng phương pháp này, mỗi khi mở văn bản, âm thanh sẽ ñược phát ra ngay, cụ thể cần 

thực hiện như sau : 
o Click chuột phải vào chỗ trống bất kỳ trên thanh công cụ, chọn dấu check vào chữ Web Tools. 
o Trên thanh Web Tools, bạn thấy biểu tượng hình cái loa có dấu mũi tên chỉ vào văn bản, click 

chuột vào nó, hộp thoại sau ñây sẽ hiện ra : 

 
o Click vào chữ Browse rồi chọn ñịa chỉ file âm thanh (chỉ dùng ñược các file dạng 

*.midi,*.wav,*.mid,*.rmi,*au,*.aif,*.aiff,*.snd) 
o Click vào dấu mũi tên trước chữ times ñể chọn số lần lập lại âm thanh. 
o Sau ñó click chuột vào nút OK là xong. 

  
• Phương pháp 2 : Dùng chức năng Insert Comment  

o Phương pháp này có thể quản lý ñược lúc nào nên phát âm thanh, lúc nào không. 
o Muốn chèn âm thanh ở ñoạn văn bản nào, bạn bao khối ñoạn ñó (hoặc ñặt con trỏ ở cuối 

ñoạn), sau ñó bấm chuột phải vào chỗ trống bất kỳ trên thanh công cụ, mở thanh Reviewing. 
Bạn rê chuột vào biểu tượng New Comment, click vào dấu mũi tên chỉ xuống ở bên cạnh sẽ 
thấy menu thả như hình dưới ñây : 

 
o Bạn click chuột vào chữ Voice Comment sẽ thấy một hộp thoại hiện ra như sau : 
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o Nếu máy bạn có sound card và micro, bạn có thể ghi âm lời của mình ñể chú thích cho ñoạn 
văn bản. Còn nếu bạn muốn chèn nhạc, hãy mở menu Edit>Mix with File như hình bên dưới, rồi 
chỉ ñịnh ñiạ chỉ cho file nhạc (lưu ý : chỉ chèn ñược các file ñịnh dạng *.wav) 

 
o Sau khi hoàn tất các bước trên, bạn mở menu File, chọn Exit & Return to Document.Bạn sẽ thấy 

cuối ñoạn văn bản xuất hiện biểu tượng cái loa như vầy  
o Nếu muốn nghe âm thanh : bạn bấm ñúp chuột vào nó, muốn hiệu chỉnh lại âm thanh : nhấp 

chuột phải, chọn Sound Recorder Document Object>Edit, muốn xóa bỏ âm thanh : nhấp chuột 
vào nó một lần rồi bấm Delete. 
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CẮT GHÉP CÁC TẬP TIN ÂM THANH BẰNG TIỆN ÍCH CÓ SẴN TRONG WINDOWS XP 

  
   

Nếu bạn muốn cắt nhỏ hoặc ghép nối các tập tin Audio và Movie giúp cho việc lưu trữ và xử lý tốt hơn . Bạn 
không cần phải tải về thêm bất kỳ chương trình nào cả Vì trong Windows XP ñã có tích hợp sẵn một tiện ích khá 
hay có khả năng làm ñược công việc này . ðó là tiện ích Windows Movie Maker ( WMM ) ( All Programs > 
Accessories > Windows Movie Maker hoặc Menu Start > Run > moviemk.exe ) .  
- Cắt tập tin âm thanh , video  

+ ðể cắt một File Video và âm thanh , bạn cần qua các bước sau :  
* Bước 1 : Vào Menu File > Import ñể nhập tập tin nguồn vào . WMM hỗ trợ khá nhiều ñịnh 

dạng Audio và Movies như asf , au , avi , dat , m1v , mp2 , mp3 , mpeg , snd ,wma , wav …  
* Bước 2 : Kéo và thả tập tin cần cắt nhỏ vào thanh StoryBoard / TimeLine phía dưới cửa sổ 

chương trình 

 
*Bước 3 : Kéo ñến vị trí ñầu ñoạn phim , âm thanh bạn cần trích và kéo ñến vị trí cuối ñoạn . Sau ñó 

nhấn nút ñể nghe thử ñoạn trích .  
*Bước cuối cùng : Sau khi ñã hài lòng , bạn vào Menu File > Save Movies . Hộp thoại Save Movie xuất 

hiện , Trong phần setting bạn có thể tùy ý chọn chất lượng là Low , Medium hay High quality ( Nên nhớ chất 
lượng càng cao thì dung lượng tập tin càng khổng lồ ) . Phần Display Information , ñiền vào Title ( tiêu ñề ) 
Author ( Tác giả ) Date ( ngày tạo ) Description ( mô tả ) … nếu cảm thấy cần thiết . Sau ñó nhấn Ok và chọn 
nơi lưu tập tin . Lưu ý : Windows Movie Maker chỉ hỗ trợ lưu dưới ñịnh dạng là WMV mà thôi . 



Sưu Tầm Thủ Thuật                                               traitimbinhyen_nova@yahoo.com 

http://vietdown.org                                                                                                   Nguyễn Anh Tú         

 
o Ngoài ra Windows Movie Maker còn có khả năng tự ñộng cắt nhỏ thành nhiều ñoạn theo thời 

lượng ( tính bằng giây ) . ðể WMM tự ñộng chia bài nhạc thành nhiều ñoạn có cùng thời lượng 
là 20 giây , bạn vào Menu View > Options . Trong hộp thoại Options , bạn ñánh dấu chọn vào Ô 
kiểm “ Automatically create clips “ , nhập thời lượng của mỗi ñoạn vào “ Default imported photo 
duration ( seconds ) : “ ( Ở ñây tôi nhập vào 20 giây ) . Sau ñó nhấn OK . Từ nay , sau khi 
Import bất kì tập tin audio hay Video nào , WMM luôn tự chia nhỏ tập tin thành nhiều ñoạn với 
mỗi ñoạn ñều dài 20 giây . 

 
• Ghép nối các tập tin âm thanh , video  

o ðể ghép nhiều tập tin , ñoạn nhạc vào thành một tập tin duy nhất . Tương tự như phần cắt nhỏ 
, bạn phải Import các tập tin , kéo và thả những tập tin cần nối vào StoryBoard / TimeLine và 
sau ñó là lưu lại . Thế là xong . Quá dễ phải không nào ?  
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CẢI THIỆN TỐC ðỘ TRONG WINDOWS XP 
  

 
    Hiện winXP ñang là một trong những hệ ñiều hành ñược ưa thích bởi vẻ ñẹp và các tính năng mới của nó . 
ðối với các máy tính cấu hình mạnh thì việc chạy WinXP trở nên dễ dàng . Còn ñối với các máy cấu hình yếu , 
ñã lỗi thời thì Win XP chạy khá chậm. Trong bài viết này , xin trình bày với các bạn một thủ thuật làm cho Win 
XP của bạn chạy nhanh hơn và tiết kiệm tài nguyên cảu hệ thống Tí xíu . 
 
1 . Tắt bớt các dịch vụ không sử dụng : 
 
    Có một số dịch vụ bạn có thể tắt bớt , việc này sẽ giúp cải thiện tốc ñộ và tài nguyên cho máy . Tìm ñọc các 
mô tả về các Dịch vụ , nếu thấy dịch vụ nào không thật sự cần thiết . bạn có thể nhấp kép vào dịch vụ ñó rồi 
chọn Disable ñể vô hiệu hóa chúng bạn có thể tìm thấy khá nhiều dịch vụ trong Group policy ( Start > run , gõ 
gpedit.msc ) hay trong Administrative Tools ( nằm trong Control Panel ) . Một vài dịch vụ không cần thiết , bạn 
có thể tắt mà không ảnh hưởng ñến hệ thống :  

•  Alerter ; Universal Plug and Play Device Host ; Human Interface Devices ; Net Logon ; Indexing Service 
; Messenger ; QOS RSVP ; Web Client ; Remote Registry ; Routing & Remote Access ; Fast 
UserSwitching ; Application Management ; Remote Desktop Help Session Manager ; SSDP Discovery 
Service ; Clipbook … : các dịch vụ này ñều nằm trong Trong Control Panel > Administrative Tools > 
Component Services > Services ( local ) . Chọn và nhấp kép vào các dịch vụ trên , trong Startup type , 
chọn Disable ñể không cho tự khởi ñộng với máy hoặc Stopped trong Service Status nếu thấy không cần 
dùng ñến nữa .  

 
  

2 . Dọn dẹp thư mục Prefecth và Temp. 
 
    Prefecth là nét ñặt trưng mới của Win XP ., nơi ñây lưu giữ các Shortcut của các chương trình bạn thường sử 
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dụng nhằm giúp việc mở chương trình nhanh hơn . Tuy nhiên , càng về sau thư mục này càng bị ñầy ñi bởi vì 
chứa quá nhiều shortcut của các chương trình . ðể dọn dẹp sạch thư mục này , bạn vào thư mục gốc của 
windows chọn thư mục prefecht và xóa tất cả những thứ có trong thư mục ñó . ( Như trong máy tôi là 
C:/Windows/Prefecth ) . Sẵn dịp , bạn vào thêm thư mục Temp cùng nằm trong thư mục Windows ñể dọn dẹp 
luôn các File Tạm do quá trình cài ñặt các phần mềm ñể lại .  
 
3 . Không hiển thị thông tin trạng thái khi tắt , mở máy … 
Khi bạn tắt mở máy , bạn sẽ gặp các thông ñiệp của Windows như Windows is shutting down , saving user’s 
setting … Bạn có thể vô hiệu hóa chúng nếu thấy không cần thiết bằng cách  

• Cách 1 : bạn có thể vào GroupPolicy ( start > run > gpedit.msc ) tìm ñến Remove Boot / Shutdown / 
Logon / Logoff Status messages trong Computer Configuration > Administrative Templates > system . 
Nhấp kép chuột và chọn Enable ñể bật tính năng này .  

• Cách 2 : Nếu bạn không tìm thấy dòng Remove Boot / Shutdown / Logon / Logoff Status messages 
trong Group Policy ở cách trên, bạn có thể mở Regedit ( Start > run > Regedit ) , tìm ñến 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\policies\system . Tìm khóa 
DisableStatusMessages và gán giá trị ( value ) là 1 . Nếu chưa có , bạn có thể tạo mới bằng cách chọn 
new > Dword Value và gõ DisableStatusMessages . sau ñó vẫn gán giá trị là 1 như trên .  

 
  

4 . Không sử dụng giao diện ñồ họa lúc khởi ñộng  
    Nếu bạn không cần xem Logo cái Logo khởi ñộng nhàm chán của Windows XP . bạn có thể không sử dụng 
giao diện giao diện ñồ hòa ( GUI ) trong lúc khởi ñộng Win . Vào Start > run >msconfig . Chọn thẻ Boot.ini . 
ñánh dấu chọn vào ô /NOGUIBOOT rồi chọn apply , khởi ñộng lại ñể xem kết quả . 
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CÁCH SETUP BIOS  

    Khi khởi ñộng máy lần ñầu tiên, máy tính sẽ ñọc một tập hợp dữ liệu ñược lưu trong CMOS (một chip bộ nhớ 
ñặc biệt luôn hoạt ñộng nhờ 1 cục pin nhỏ), không có thông tin nầy máy tính sẽ bị tê liệt. Việc xác lập các thông 
tin nầy gọi là Setup Bios và bao giờ người bán cũng phải làm thủ tục Setup Bios ngay sau khi ráp máy. Nhưng 
bạn cũng phải biết cách Setup Bios ñể ñề phòng trường hợp máy tự mất các thông tin lưu trong Bios vì các lý 
do như: Hết pin, nhiễu ñiện, virus...Hiện nay, người ta dùng Flash Ram ñể lưu thông tin Bios nên không cần 
phải có Pin nuôi trên mainboard. Tùy Mainboard, các mục trong Bios có thể khác nhau theo từng hãng chế tạo 
(Award, Ami, Pheonix...) nhưng về căn bản chúng vẫn giống nhau và trong phần nầy chủ yếu bàn về căn bản, 
còn các tính năng riêng bạn phải chịu khó tìm hiểu thêm nhờ vào các kiến thức căn bản nầy. 

     Màn hình Bios Setup ña số là màn hình chạy ở chế ñộ TEXT. Gần ñây ñang phát triển loại BiosWin (Ami) có 
màn hình Setup gồm nhiều cửa sổ giống tương tự Windows và sử dụng ñược Mouse trong khi Setup nhưng các 
mục vẫn không thay ñổi. 

    Chú ý thao tác ñể vào Bios Setup là: Bấm phím Del khi mới khởi ñộng máy ñối với máy Ðài Loan. Ðối với 
các máy Mỹ, thường là bạn phải thông qua chương trình quản lý máy riêng của từng hãng nếu muốn thay ñổi 
các thông số của Bios. 

    * Bios thường: Di chuyển vệt sáng ñể lựa chọn mục bằng các phím mũi tên. Thay ñổi giá trị của mục ñang 
Set bằng 2 phím Page Up và Page Dn. Sau ñó nhấn phím Esc ñể thoát khỏi mục (giá trị mới sẽ ñược lưu trữ). 
Nhấn F10 ñể thoát Setup Bios nếu muốn lưu các thay ñổi, khi hộp thoại hiện ra, bấm Y ñể lưu, N ñể không lưu. 
Nhấn Esc nếu muốn thoát mà không lưu thay ñổi, khi hộp thoại hiện ra, bấm Y ñể không lưu, N ñể trở lại màn 
hình Setup Bios. 

    * Bios Win: Màn hình Setup xuất hiện dưới dạng ñồ họa gồm nhiều cửa sổ, sử dụng ñược mouse nếu bạn có 
mouse loại: PS/2 mouse, Microsoft mouse, Serial mouse, Logitect C mouse. Dùng mouse bấm kép vào cửa sổ 
ñể mở một thành phần, bấm vào mục cần thay ñổi, một cửa sổ liệt kê giá trị xuất hiện, bấm vào giá trị muốn 
chọn rồi thoát bằng cách bấm vào ô nhỏ ở góc trên bên trái. Nếu không có mouse, dùng các phím mũi tên ñể di 
chuyển, ñến mục cần thay ñổi bấm Enter, xuất hiện hộp liệt kê, chọn giá trị mới, bấm Enter, cuối cùng bấm Esc. 

    1. Setup các thành phần căn bản (Standard CMOS Setup): 

     Ðây là các thành phần cơ bản mà Bios trên tất cả các loại máy PC phải biết ñể quản lý và ñiều khiển chúng. 

    * Ngày, giờ (Date/Day/Time): 

    Bạn khai báo ngày tháng năm vào mục nầy. Khai báo nầy sẽ ñược máy tính xem là thông tin gốc và sẽ bắt 
ñầu tính từ ñây trở ñi. Các thông tin về ngày giờ ñược sử dụng khi các bạn tạo hay thao tác với các tập tin, thư 
mục. Có chương trình khi chạy cũng cần thông tin nầy, thí dụ ñể báo cho bạn cập nhật khi quá hạn, chấm dứt 
hoạt ñộng khi ñến ngày quy ñịnh...Bình thường bạn Set sai hay không Set cũng chẳng nh hưởng gì ñến hoạt 
ñộng của máy. Các thông tin nầy có thể sửa chữa trực tiếp ngoài Dos bằng 2 lịnh Date và Time, hay bằng 
Control Panel của Windows mà không cần vào Bios Setup. 

     Chú ý: Ðồng hồ máy tính luôn luôn chạy chậm khong vài giây/ngày, thỉnh thoảng bạn nên chỉnh lại giờ cho 
ñúng. Nhưng nếu quá chậm là có vấn ñề cần phải thay mainboard. 

    * ổ ñĩa mềm (Drive A/B): 

      Khai báo loại ổ ñĩa cho ổ A và ổ B, bạn căn cứ vào việc nối dây cho ổ ñĩa ñể xác ñịnh. ổ ñĩa nối với ñầu nối 
ngoài cùng của dây nối là ổ A, ổ kia là B. ổ có kích thước lớn là 1.2M 5.25 inch, ổ nhỏ là 1.44M 3.5 inch. Nếu 
không có thì chọn Not Installed. Nếu bạn khai báo sai, ổ ñĩa sẽ không hoạt ñộng chớ không hư hỏng gì, bạn chỉ 
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cần khai báo lại. Trong các mainboard sử dụng Bios ñời mới, khai báo sai loại ổ dĩa 1.2Mb thành 1.4Mb hay 
ngược lại, ổ dĩa vẫn hoạt ñộng bình thường nhưng kêu rất lớn lúc mới bắt ñầu ñọc ñĩa, về lâu dài có thể hư ñĩa. 

      Các Bios và các card I/O ñời mới cho phép bạn tráo ñổi 2 ổ ñĩa mềm mà không cần tráo ñổi dây (swap 
floppy drive), tức là ổ A thành ổ B và ngược lại khi sử dụng. Khi tráo ñổi bằng cách Set jumper trên card I/O, bạn 
nhớ khai báo lại trong Bios Setup (Khi tráo bằng lịnh Swap trong Bios thì không cần khai báo lại), nhưng có ứng 
dụng không chịu cài ñặt khi Swap ñĩa mềm, nhất là các ứng dụng có bảo vệ chống sao chép. 

     * ổ ñĩa cứng (Drive C/D) loại IDE: 

    Phần khai báo ổ ñĩa cứng rắc rối hơn, bắt buộc bạn phải khai báo chi tiết các thông số, bạn khai báo sai 
không những ổ cứng không hoạt ñộng mà ñôi khi còn làm hư ổ cứng nếu bạn khai báo quá dung lượng thật sự 
của ổ cứng và cho tiến hành FDISK, FORMAT theo dung lượng sai nầy. May mắn là các Bios sau nầy ñều có 
phần dò tìm thông số ổ cứng IDE tự ñộng (IDE HDD auto detection) nên các bạn khỏi mắc công nhớ khi sử 
dụng ổ ñĩa cứng loại IDE. Chúng tôi sẽ nói về phần auto detect nầy sau. Ngoài ra, các ổ cứng sau nầy ñều có 
ghi thông số trên nhãn dán trên mặt. Bạn cho chạy Auto detect, Bios sẽ tự ñộng ñiền các thông số nầy dùm bạn. 
Việc khai báo ổ cứng C và D ñòi hỏi phải ñúng với việc Set các jumper trên 2 ổ cứng. Bạn xác lập ổ cứng không 
phải qua ñầu nối dây mà bằng các jumper trên mạch ñiều khiển ổ cứng. Các ổ cứng ñời mới chỉ có một jumper 
3 vị trí: ổ duy nhất, ổ Master (ổ C), ổ Slave (ổ D) và có ghi rõ cách Set trên nhãn. Các ổ ñĩa cứng ñời cũ nhiều 
jumper hơn nên nếu không có tài liệu hướng dẫn là rắc rối, phải mò mẫm rất lâu. 

     * ổ ñĩa cứng (Drive E/F) loại IDE: 

      Các Bios và các card I/O ñời mới cho phép gắn 4 ổ dĩa cứng, vì hiện nay các ổ dĩa CDROM cũng sử dụng 
ñầu nối ổ cứng ñể hoạt ñộng, gọi là CDROM Interface IDE (giao diện ñĩa IDE) ñể ñơn giản việc lắp ñặt. 

     Chú ý: Khai báo là NONE trong Bios Setup cho ổ ñĩa CD-ROM. 

     * Màn hình (Video) - Primary Display: 

EGA/VGA: Dành cho loại màn hình sử dụng card màu EGA hay VGA, Super VGA. 

       CGA 40/CGA 80: Dành cho loại màn hình sử dụng card màu CGA 40 cột hay CGA 80 cột. 

       Mono: Dành cho loại màn hình sử dụng card trắng ñen, kể c card VGA khi dùng màn hình trắng ñen. 

      * Treo máy nếu phát hiện lỗi khi khởi ñộng (Error Halt): 

    Tất cả lỗi (All error): Treo máy khi phát hiện bất cứ lỗi nào trong quá trình kiểm tra máy, bạn không nên chọn 
mục nầy vì Bios sẽ treo máy khi gặp lỗi ñầu tiên nên bạn không thể biết các lỗi khác, nếu có. 

       Bỏ qua lỗi của Keyboard (All, But Keyboard): Tất cả các lỗi ngoại trừ lỗi của bàn phím. 

       Bỏ qua lỗi ñĩa (All, But Diskette): Tất cả các lỗi ngoại trừ lỗi của ñĩa. 

       Bỏ qua lỗi ñĩa và bàn phím (All, But Disk/Key): Tất cả các lỗi ngoại trừ lỗi của ổ ñĩa và bàn phím. 

       Không treo máy khi có lỗi (No error): Tiến hành quá trình kiểm tra máy cho ñến khi hoàn tất dù phát hiện bất 
cứ lỗi gì. Bạn nên chọn mục nầy ñể biết máy bị trục trặc ở bộ phận nào mà có phương hướng giải quyết. 

      * Keyboard: 
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    Install: Cho kiểm tra bàn phím trong quá trình khởi ñộng, thông báo trên màn hình nếu bàn phím có lỗi. 

       Not Install: Không kiểm tra bàn phím khi khởi ñộng. Chú ý: chọn mục nầy không có nghĩa là vô hiệu hoá 
bàn phím vì nếu vậy làm sao ñiều khiển máy. Nó chỉ có tác dụng cho Bios khỏi mất công kiểm tra bàn phím 
nhằm rút ngắn thời gian khởi ñộng. 

      2. Setup các thành phần nâng cao (Advanced Setup): 

    * Virut Warning: 

    Nếu Enabled, Bios sẽ báo ñộng và treo máy khi có hành ñộng viết vào Boot sector hay Partition của ñĩa 
cứng. Nếu bạn cần chạy chương trình có thao tác vào 2 nơi ñó như: Fdisk, Format... bạn cần phải Disable mục 
nầy. 

    * Internal cache: 

    Cho hiệu lực (enable) hay vô hiệu hoá (disable) Cache (L1) nội trong CPU 486 trở lên. 

    * External cache: 

       Cho hiệu lực (enable) hay vô hiệu hoá (disable) cache trên mainboard, còn gọi là Cache mức 2 (L2). 

      * Quick Power On Self Test: 

       Nếu enable Bios sẽ rút ngắn và bỏ qua vài mục không quan trọng trong quá trình khởi ñộng, ñể giảm thời 
gian khởi ñộng tối ña. 

      * About 1 MB Memory Test: 

       Nếu Enable Bios sẽ kiểm tra tất cả bộ nhớ. Nếu Disable Bios chỉ kiểm tra 1 Mb bộ nhớ ñầu tiên. 

      * Memory Test Tick Sound: 

       Cho phát âm thanh (enable) hay không (disable) trong thời gian test bộ nhớ. 

      * Extended Bios Ram Area: 

    Khai báo mục nầy nếu muốn dùng 1 Kb trên ñỉnh của bộ nhớ quy ước, tức Kb bắt ñầu từ ñịa chỉ 639K hay 
0:300 của vùng Bios hệ thống trong bộ nhớ quy ước ñể lưu các thông tin về ñĩa cứng. Xác lập có thể là 1K hay 
0:300. 

     * Swap Floppy Drive: 

      Tráo ñổi tên 2 ổ ñĩa mềm, khi chọn mục nầy bạn không cần khai báo lại loại ổ ñĩa như khi tráo bằng cách 
Set jumper trên card I/O. 

     * Boot Sequence: 

    Chọn ổ ñĩa cho Bios tìm hệ ñiều hành khi khởi ñộng. Có thể là C rồi ñến A hay A rồi ñến C hay chỉ có C. Bạn 
nên chọn C,A hay chỉ có C, ñể ñề phòng trường hợp vô tình khởi ñộng bằng ñĩa mềm có Virus. 
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     Hiện nay trên các Mainboard Pentium. Bios cho phép bạn chỉ ñịnh khởi ñộng từ 1 trong 2 ổ mềm hay trong 4 
ổ cứng IDE hay bằng ổ cứng SCSI thậm chí bằng ổ CD Rom cũng ñược. 

    * Boot Up Floppy Seek: 

     Nếu Enable Bios sẽ dò tìm kiểu của ñĩa mềm là 80 track hay 40 track. Nếu Disable Bios sẽ bỏ qua. Chọn 
enable làm chậm thời gian khởi ñộng vì Bios luôn luôn phải ñọc ñĩa mềm trước khi ñọc ñĩa cứng, mặc dù bạn 
ñã chọn chỉ khởi ñộng bằng ổ C. 

    * Boot Up Numlock Status: 

     Nếu ON là cho phím Numlock mở (ñèn Numlock sáng) sau khi khởi ñộng, nhóm phím bên tay phải bàn phím 
dùng ñể ñánh số. Nếu OFF là cho phím Numlock tắt (ñèn Numlock tối), nhóm phím bên tay phải dùng ñể di 
chuyển con trỏ. 

    * Boot Up System Speed: 

    Quy ñịnh tốc ñộ của CPU trong thời gian khởi ñộng là High (cao) hay Low (thấp). 

     * Memory Parity Check: 

      Kiểm tra chẵn lẻ bộ nhớ. Chọn theo mainboard vì có loại cho phép mục nầy enable, có loại bắt bạn phải 
disable mới chịu chạy. Ðầu tiên bạn chọn enable, nếu máy treo bạn chọn lại là disable. Mục nầy không ảnh 
hưởng ñến hệ thống, chỉ có tác dụng kiểm tra Ram. 

     * IDE HDD Block Mode: 

      Nếu ổ ñĩa cứng của bạn hỗ trợ kiểu vận chuyển dữ liệu theo từng khối (các ổ ñĩa ñời mới có dung lượng 
cao). Bạn cho enable ñể tăng tốc cho ổ ñĩa. Nếu ổ ñĩa ñời cũ bạn cho disable mục nầy. 

     * Pri. Master/Slave LBA (Logic Block Addressing) Mode: 

      Nếu 2 ổ ñĩa cứng ñược nối vào ñầu nối Primary của card I/O có dung lượng lớn hơn 528Mb, bạn cho enable 
mục nầy. 

     * Sec. IDE Ctrl Drives Install: 

      Mục nầy ñể khai báo máy bạn có ổ ñĩa cứng nối vào ñầu nối Secondary của card I/O. Các chỉ ñịnh có thể là 
Master, Mst/Slv và disable. 

     * Sec Master/Slave LBA Mode: 

      Xác lập LBA cho ñầu nối thứ 2. 

      Chú ý: Các mục hỗ trợ cho ổ ñĩa cứng có dung lượng lớn và các card I/O ñời mới giúp bạn sử dụng ổ ñĩa có 
dung lượng trên 528Mb. Trong trường hợp bạn cho enable các mục nầy rồi mới tiến hành Fdisk và Format ñĩa, 
nếu sau ñó bạn lại disable các mục nầy hay ñem gắn qua máy khác cũng chọn disable, bạn sẽ không thể sử 
dụng ñược ổ dĩa cứng. Khi dùng ổ CDROM có ñầu nối IDE, bạn nên gắn vào ñầu nối Secondary ñể khỏi ảnh 
hưởng ñến ổ dĩa cứng (gắn vào ñầu nối Pri) khi cần chạy 32BitDiskAccess trong Windows. 

     * Typematic Rate Setting: 
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      Nếu enable là bạn cho 2 mục dưới ñây có hiệu lực. 2 mục nầy thay thế lịnh Mode của DOS, quy ñịnh tốc ñộ 
và thời gian trể của bàn phím. 

     * Typematic Rate (Chars/Sec): 

      Bạn lựa chọn số ký tự/giây tuỳ theo tốc ñộ ñánh phím nhanh hay chậm của bạn. Nếu bạn Set thấp hơn tốc 
ñộ ñánh thì máy sẽ phát tiếng Bip khi nó chạy theo không kịp. 

     * Typematic Delay (Msec): 

      Chỉ ñịnh thời gian lập lại ký tự khi bạn bấm và giữ luôn phím, tính bằng mili giây. 

     * Security Option: 

      Mục nầy dùng ñể giới hạn việc sử dụng hệ thống và Bios Setup. 

      Setup: Giới hạn việc thay ñổi Bios Setup, mỗi khi muốn vào Bios Setup bạn phải ñánh ñúng mật khẩu ñã 
quy ñịnh trước. 

      System hay Always: Giới hạn việc sử dụng máy. Mỗi khi mở máy, Bios luôn luôn hỏi mật khẩu, nếu không 
biết mật khẩu Bios sẽ không cho phép sử dụng máy. 

      Chú ý: Trong trường hợp bạn chưa chỉ ñịnh mật khẩu, ñể Disable (vô hiệu hoá) mục nầy, bạn chọn 
Password Setting, bạn ñừng ñánh gì vào các ô nhập mật khẩu mà chỉ cần bấm ENTER. Trong trường hợp bạn 
ñã có chỉ ñịnh mật khẩu nay lại muốn bỏ ñi. Bạn chọn Password Setting, bạn ñánh mật khẩu cũ vào ô nhập mật 
khẩu cũ (Old Password) còn trong ô nhập mật khẩu mới (New Password) bạn ñừng ñánh gì cả mà chỉ cần bấm 
ENTER. Có mainboard thiết kế thêm 1 jumper ñể xoá riêng mật khẩu ngoài jumper ñể xoá toàn bộ thông tin 
trong CMOS. Tốt hơn hết là bạn ñừng sử dụng mục nầy vì bản thân chúng tôi chứng kiến rất nhiều trường hợp 
dở khóc dở cười do mục nầy gây ra. Lợi ít mà hại nhiều. Chỉ những máy tính công cộng mới phải sử dụng tới 
mục nầy thôi. 

     * System Bios Shadow, Video Bios Shadow: 

      Nếu enable là cho copy các dữ liệu về System và Video trong Bios (có tốc ñộ chậm) vào Ram (tốc ñộ 
nhanh) ñể rút ngắn thời gian khi cần truy nhập vào các dữ liệu nầy. 

     * Wait for <F1> if Any Error: 

      Cho hiện thông báo chờ ấn phím F1 khi có lỗi. 

     * Numeric Processor: 

    Thông báo có gắn CPU ñồng xử lý (Present) trên máy hay không (absent). Mục nầy thường có cho các máy 
dùng CPU 286, 386, 486SX. Từ 486DX trở về sau ñã có con ñồng xử lý bên trong CPU nên trên các máy mới 
có thể không có mục nầy. 

     * Turbo Switch Funtion: 

      Cho nút Turbo có hiệu lực (enable) hay không (disable). Mục nầy thường thấy ở các Bios ñời củ, trên các 
máy ñời mới lựa chọn nầy thường bằng cách Set jumper của Mainboard. Từ Mainboard pentium trở ñi không có 
mục nầy. 
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     3. Setup các thành phần có liên quan ñến vận hành hệ thống (Chipset Setup): 

     * Auto Configuration: 

      Nếu enable, Bios sẽ tự ñộng xác lập các thành phần về DRAM, Cache...mỗi khi khởi ñộng tùy theo CPU 
Type (kiểu CPU) và System Clock (tốc ñộ hệ thống). Nếu Disable là ñể cho bạn tự chỉ ñịnh. 

     * AT Clock Option: 

      Nếu Async (không ñồng bộ) là lấy dao ñộng chuẩn của bộ dao ñộng thạch anh chia ñôi làm tốc ñộ hoạt 
ñộng cho AT Bus (bus 8 - 16Bit). Thường là 14.318MHz/2 tức 7.159MHz. Có Bios còn cho chọn tốc ñộ của mục 
nầy là 14.318MHz. Nếu Sync (ñồng bộ) là dùng System Clock (do bạn chỉ ñịnh bằng cách Set jumper trên 
mainboard) làm tốc ñộ chuẩn. 

     * Synchronous AT Clock/AT Bus Clock Selector: 

      Chỉ ñịnh tốc ñộ hoạt ñộng cho AT Bus bằng cách lấy tốc ñộ chuẩn (system clock) chia nhỏ ñể còn lại khoảng 
8MHz cho phù hợp với card 16Bit. Các lựa chọn như sau: 

      CLKI/3 khi system clock là 20 - 25MHz. 

      CLKI/4 khi system clock là 33MHz. 

      CLKI/5 khi system clock là 40MHz. 

      CLKI/6 khi system clock là 50MHz. 

      Tốc ñộ nầy càng lớn (số chia càng nhỏ), máy chạy càng nhanh do tăng tốc ñộ vận chuyển dữ liệu. Tuy 
nhiên lớn ñến ñâu là còn tùy thuộc vào mainboard và card cắm trên các Slot (quan trọng nhất là card I/O). Các 
bạn phải thí nghiệm giảm số chia từng nấc và chú ý máy có khởi ñộng hay ñọc ñĩa bình thường không, nếu phát 
sinh trục trặc thì giảm xuống 1 nấc. Thường thì bạn có thể tăng ñược 2 nấc, thí dụ: System clock là 40MHz, bạn 
chọn CLKI/3. Card ISA 8 và 16 Bit có thể chạy tốt trong khoảng từ 8MHz ñến 14MHz. Nếu nhanh quá, thường 
card I/O gặp trục trặc trước (không ñọc ñược ñĩa cứng). 

     * AT Cycle Wait States/Extra AT Cycle WS: 

      Ðể enable hay disable việc chèn thêm 1 thời gian chờ vào thời gian chuẩn của AT Bus. Nếu system clock 
dưới 33MHz chọn disable. Nếu trên 33MHz chọn enable. 

     * Fast AT Cycle: 

      Khi enable sẽ rút ngắn thời gian chuẩn của AT Bus. 

     * DRAM Read Wait States/DRAM Brust Cycle: 

      Dưới 33MHz là: 3 - 2 - 2 - 2 hay 2 - 1 - 1 - 1 

      Từ 33 - 45MHz là: 4 - 3 - 3 - 3 hay 2 - 2 - 2 - 2 

      50MHz là: 5 - 4 - 4 - 4 hay 3 - 2 - 2 - 2 

      Chọn mục nầy ảnh hưởng lớn ñến tốc ñộ CPU. 
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     * DRAM/Memory Write Wait States: 

      Chọn 1WS khi hệ thống nhanh hay DRAM chậm (tốc ñộ 40MHz trở lên). Chọn 0WS khi hệ thống và DRAM 
có thể tương thích (33MHz trở xuống). 

     * Hidden Refresh Option: 

      Khi enable, CPU sẽ làm việc nhanh hơn do không phải chờ mỗi khi DRAM ñược làm tươi. 

     * Slow Refresh Enable: 

      Mục nầy nhằm bảo ñảm an toàn dữ liệu trên DRAM, thời gian làm tươi sẽ kéo dài hơn bình thường. Bạn chỉ 
ñược enable mục nầy khi bộ nhớ của máy hỗ trợ việc cho phép làm tươi chậm. 

     * L1 Cache Mode: 

      Lựa chọn giữa Write-Through và Write-Back cho Cache nội trong CPU 486 trở lên. Xác lập Write-Through 
máy sẽ chạy chậm hơn Write-Back nhưng việc lực chọn còn tuỳ thuộc vào loại CPU. 

     * L2 Cache Mode: 

      Xác lập cho cache trên mainboard. 

     * IDE HDD Auto Detection/IDE SETUP: 

      Khi chọn mục nầy sẽ xuất hiện một cửa sổ cho bạn chỉ ñịnh ổ ñĩa cần dò tìm thông số (2 hay 4 ổ ñĩa tuỳ 
theo Bios). Sau ñó bạn bấm OK hay YES ñể Bios ñiền vào phần Standard dùm cho bạn. Trong Bios ñời mới, 
Auto detect có thể ñưa ra vài loại ổ ñĩa. Tuỳ theo cách sử dụng ổ dĩa (normal, LBA,...) mà bạn chọn loại thích 
hợp. 

     * Power Management Setup: 

     Ðối với CPU 486: 

      Phần nầy là các chỉ ñịnh cho chương trình tiết kiệm năng lượng sẵn chứa trong các Bios ñời mới. Chương 
trình nầy dùng ñược cho cả 2 loại CPU: Loại thường và loại CPU kiểu S. CPU kiểu S hay CPU có 2 ký tự cuối 
SL là một loại CPU ñược chế tạo ñặc biệt, có thêm bộ phận quản lý năng lượng trong CPU. Do ñó trong phần 
nầy có 2 loại chỉ ñịnh dành cho 2 loại CPU. 

     Ðối với Pentium: 

      Dùng chung cho mọi loại Pentium hay các chíp của các hảng khác cùng ñời với Pentium. 

     * Power Management/Power Saving Mode: 

      Disable: Không sử dụng chương trình nầy. 

      Enable/User Define: Cho chương trình nầy có hiệu lực. 

      Min Saving: Dùng các giá trị thời gian dài nhất cho các lựa chọn (tiết kiệm năng lượng ít nhất). 
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      Max Saving: Dùng các giá trị thời gian ngắn nhất cho các lựa chọn (tiết kiệm nhiều nhất). 

     * Pmi/Smi: 

      Nếu chọn SMI là máy ñang gắn CPU kiểu S của hãng Intel. Nếu chọn Auto là máy ñang gắn CPU thường. 

     * Doze Timer: 

      Mục nầy chỉ dùng cho CPU kiểu S. Khi ñúng thời gian máy ñã rảnh (không nhận ñược tín hiệu từ các ngắt) 
theo quy ñịnh, CPU tự ñộng hạ tốc ñộ xuống còn 8MHz. Bạn chọn thời gian theo ý bạn (có thể từ 10 giây ñến 4 
giờ) hay disable nếu không muốn sử dụng mục nầy. 

     * Sleep Timer/Standby timer: 

      Mục nầy chỉ dùng cho CPU kiểu S. Chỉ ñịnh thời gian máy rảnh trước khi vào chế ñộ Sleep (ngưng hoạt 
ñộng). Thời gian có thể từ 10 giây ñến 4 giờ. 

     * Sleep Clock: 

      Mục nầy chỉ dùng cho CPU kiểu S: Stop CPU hạ tốc ñộ xuống còn 0MHz (ngưng hẳn). Slow CPU hạ tốc ñộ 
xuống còn 8MHz. 

     * HDD Standby Timer/HDD Power Down: 

      Chỉ ñịnh thời gian ngừng motor của ổ ñĩa cứng. 

     * CRT Sleep: 

      Nếu Enable là màn hình sẽ tắt khi máy vào chế ñộ Sleep. 

     * Chỉ ñịnh: 

      Các chỉ ñịnh cho chương trình quản lý nguồn biết cần kiểm tra bộ phận nào khi chạy. 

     Chú ý: Do Bios ñược sản xuất ñể sử dụng cho nhiều loại máy khác nhau nên các bạn luôn luôn gặp phần 
nầy trong các Bios. Thực ra chúng chỉ có giá trị cho các máy xách tay (laptop) vì xài pin nên vấn ñề tiết kiệm 
năng lượng ñược ñặt lên hàng ñầu. Chúng tôi khuyên các bạn ñang sử dụng máy ñể bàn (desktop) nên vô hiệu 
hoá tất cả các mục trong phần nầy, ñể tránh các tình huống bất ngờ như: ñang cài chương trình, tự nhiên máy 
ngưng hoạt ñộng, ñang chạy Defrag tự nhiên máy chậm cực kỳ... 

     4. Phần dành riêng cho Mainboard theo chuẩn giao tiếp PCI có I/O và IDE On Board (peripheral 
Setup): 

     * PCI On Board IDE: 

      Cho hiệu lực (enabled) hay vô hiệu (disabled) 2 ñầu nối ổ ñĩa cứng IDE trên mainboard. Khi sử dụng Card 
PCI IDE rời, ta cần chọn disabled. 

     * PCI On Board Secondary IDE: 

      Cho hiệu lực (enabled) hay vô hiệu (disabled) ñầu nối ổ ñĩa cứng IDE thứ 2 trên mainboard. Mục nầy bổ 
sung cho mục trên và chỉ có tác dụng với ñầu nối thứ 2. 
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     * PCI On Board Speed Mode: 

      Chỉ ñịnh kiểu vận chuyển dữ liệu (PIO speed mode). Có thể là Disabled, mode 1, mode 2, mode 3, mode 4, 
Auto. Trong ñó mode 4 là nhanh nhất. 

     * PCI Card Present on: 

      Khai báo có sử dụng Card PCI IDE rời hay không và nếu có thì ñược cắm vào Slot nào. Các mục chọn là: 
Disabled, Auto, Slot 1, Slot 2, Slot 3, Slot 4. 

     * PCI IRQ, PCI Primary IDE IRQ, PCI Secondary IDE IRQ: 

      Chỉ ñịnh cách xác lập ngắt cho Card PCI IDE rời. 

      Chú ý: Trong mục nầy có phần xác lập thứ tự gán ngắt cho các Card bổ sung. Thí dụ: 1 = 9, 2 = 10, 3 = 11, 
4 = 12 có nghĩa là Card ñầu tiên cắm vào bất kỳ Slot nào sẽ ñược gán ngắt 9, nếu có 2 Card thì Card cắm vào 
Slot có số thứ tự nhỏ sẽ ñược gán ngắt 9, Slot có số thứ tự lớn sẽ ñược gán ngắt 10.v..v... 

     * IDE 32Bit Transfers Mode: 

      Xác lập nầy nhằm tăng cường tốc ñộ cho ổ ñĩa cứng trên 528Mb, nhưng cũng có ổ ñĩa không khởi ñộng 
ñược khi enabled mục nầy dù fdisk và format vẫn bình thường. 

     * Host to PCI Post Write W/S, Host to PCI Burst Write, Host to DRAM Burst Write: 

      Các mục nầy xác lập cho PCU Bus, không ảnh hưởng nhiều ñến tốc ñộ CPU, có thể ñể nguyên xác lập mặc 
nhiên. 

     * PCI Bus Park, Post Write Buffer: 

      Khi enabled các mục nầy có thể tăng cường thêm tốc ñộ hệ thống. 

    * FDC Control: 

      Cho hiệu lực hay không ñầu nối cáp và xác lập ñịa chỉ cho ổ ñĩa mềm. 

     * Primary Seral Port: 

      Cho hiệu lực hay không cổng COM 1 và xác lập ñịa chỉ cho cổng nầy. 

     * Secondary Serial Port: 

      Cho hiệu lực hay không cổng COM 2 và xác lập ñịa chỉ cho cổng nầy. Chú ý: Nếu bạn sử dụng Card bổ 
sung có xác lập ñiạ chỉ là COM 1 hay COM 2, bạn phải disabled cổng tương ứng trong hai mục trên. 

     * Parallel Port: 

      Cho hiệu lực hay không cổng LPT 1 và xác lập ñịa chỉ cho cổng nầy. 

     5. Hướng dẫn Setup Bios: 
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    Trong các tài liệu ñi kèm mainboard, ñều có hướng dẫn Setup Bios. Khi mua máy hay mua mainboard, các 
bạn nhớ ñòi các tài liệu nầy vì nó rất cần cho việc sử dụng máy. 

     Trong các phần Setup trên, phần Standard, Advanced có ảnh hưởng ñến việc cấu hình máy. Phần Chipset 
ảnh hưởng ñến tốc ñộ máy. Phần PCI ảnh hưởng ñến các gán ngắt, ñịa chỉ cho các Slot PCI, cổng; cách vận 
chuyển dữ liệu cho IDE On Board. 

     Nếu gặp các thành phần hoàn toàn mới, trước tiên bạn hãy Set các thành phần ñã biết, kiểm tra việc thay ñổi 
của máy, cuối cùng mới Set tới các thành phần chưa biết. Chúng tôi xin nhắc lại, việc Setup Bios sai không bao 
giờ làm hư máy và các bạn sẽ dễ dàng Setup lại nhờ vào chính Bios. Trên mainboard luôn luôn có 1 Jumper 
dùng ñể xóa các thông tin lưu trong CMOS ñể bạn có thể tạo lại các thông tin nầy trong trường hợp không thể 
vào lại Bios Setup khi khởi ñộng máy. 

     Khi tiến hành tìm hiểu Setup Bios, bạn nên theo một nguyên tắc sau: Chỉ Set từng mục một rồi khởi ñộng 
máy lại, chạy các chương trình kiểm tra ñể xem tốc ñộ CPU, ổ ñĩa có thay ñổi gì không?. Cách làm nầy gíúp 
bạn phát hiện ñược ảnh hưởng của từng mục vào hệ thống và bạn có thể biết chắc trục trặc phát sinh do mục 
nào ñể sửa chữa. Khi xẩy ra trục trặc mà bạn không biết ñối phó, bạn chỉ cần vào lại Bios Setup chọn Load Bios 
Default hay bấm F6 trong phần Set mà bạn muốn phục hồi sau ñó khởi ñộng máy lại là xong.  

  
 

 
 
5 . Bỏ bớt các hiệu ứng ñồ họa trong Win XP  
    Mặc ñịnh , Win XP sử dụng khá nhiều hiệu ứng ñồ họa : Slide , Fade , Shadows …. ñủ thứ . Vì thế , ñã làm 
giảm tốc ñộ và tài nguyên của CPU vì phải xử lý các hiệu ứng ñó . Bạn có thể bỏ bớt một số hiệu ứng nếu CPU , 
và card ñồ họa của bạn “không phải” xịn lắm . 
    ðể tắt bớt , bạn vào system properties ( click vào chuột vào biểu tượng My Computer và chọn Properties , 
hoặc vào Control Panel > system ) , Thẻ Advance , trong phần performance chọn settings > thẻ Visual Effects 
chọn Adjust for best performance ñể giảm thiểu các hiệu ứng của Window XP ñể tốc ñộ hệ thống ñược nhưng 
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bù lại bây giờ giao diện XP chẳng khác gì Win 9x là bao .  
Nếu không , bạn có thể chọn custom ñể tự ñiều chỉnh và bỏ bớt từng hiệu ứng .  
  

 
 
 
6 . Dọn dẹp bộ nhớ ảo khi tắt máy  
    Bộ nhớ ảo ( pagefile ) là một phần của ổ ñĩa cứng ñược Windows sử dụng như bộ nhớ ñể bổ sung cho lượng 
Ram ít ỏi của mình . Bạn có thể ñiều chỉnh , tăng thêm bộ nhớ ảo này ( trên Echip các số trước ñã vài lần giới 
thiệu ) . trong bài viết xin trình bày với các bạn cách dọn dẹp bộ nhớ ảo này khi tắt máy ; ðừng lo , việc này 
Windows sẽ giúp bạn , nhưng bạn cần phải bật ñèn xanh cho tính năng này thì window mới chịu làm giùm bạn  
  

• Cách 1 : Vào Start > Control Panel > Administrative Tools > Local Security Policy > Local Policies , trong 
danh sách , chọn Shutdown : Clear virtual memory pagefile . Nhấn phải chuột > Properties > Enable > 
OK . \  

• Cách 2 : dành cho dân vọc registry . tìm ñến khóa 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Memory 
Management\ClearPageFileAtShutdown , nhấp kép gõ giá trị ( value ) là 1  
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Phòng cháy hơn chữa cháy , trước khi vọc máy , các vọc sĩ nên chuẩn bị sẵn tinh thần , sao lưu cả hệ ñiều hành 
hay Registry trước khi thực hiện những thay ñổi lớn với hệ thống . ðối với Win , bạn sử dụng các phần mềm 
như Ghost , Driver Image … ðối với registry , bạn vào menu File > Export ñể tạo bản sao lưu cho Registry  
 
Trên ñây là một số thủ thuật giúp bạn cải thiện tốc ñộ của WinXP , bạn nên sử dụng thêm microsoft Bootvis ñể 
giảm thời gian khởi ñộng máy cũng như nên hạn chế các phần mềm , ứng dụng chạy ngầm và tự khởi ñộng 
trong máy . Hy vọng với các món ñã bày trên , bạn có thể hài lòng với tốc ñộ của Win XP . 
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CÁC BƯỚC CHUẨN BỊ ðỂ TĂNG TỐC CHO WINDOWS 

  
  
I/Chuẩn bị về phần mềm: 
1.Hệ ñiều hành(OS): 
* ðối với những máy yếu(P4 1,4 hay Celeron1,7 với Ram 128 trở về trước) thì Windows 98 là hệ ñiều hành thích 
hợp nhất ñể chơi game, nhưng còn với những máy trung bình(P4 Northwood 1,8-2,4GHZ với Ram 256-512) 
hoặc những máy mạnh, nhất là các máy mới nhất hiện nay thì Windows XP là sự lựa chọn số một cho games và 
multimedia nói chung nhờ tính năng quản lí bộ nhớ vượt trội, sự ổn ñịnh,... hơn hắn so với Win 9x. 
* Theo ñánh giá của tôi thì WinXP service pack 2 có tốc ñộ tốt nhất(tuy nhiên vẫn còn gặp nhiều lỗi do xung ñột 
với một số phần mềm), sau ñó là WinXP Pro rồi XP SP1. 
* Nếu có ñiều kiện thì tốt nhất là chúng ta nên sao lưu dữ liệu quan trọng lại(tài liệu, file download, nhạc số, 
phim…) rồi..format lại ổ ñĩa của mình(nếu ổ ñĩa của bạn ñã khá cũ hay xuất hiện bad sector thì format cấp thấp 
luôn, không hại gì cả, chỉ như một lần ghi dữ liệu thôi), sau ñó mới cài lại Windows. Nếu bạn là một tay sưu tập 
phần mềm, lại ñang sử dụng toàn những phần mềm tâm ñắc thì cũng ñừng ngại gì cả, chịu khó lấy giấy ghi 
danh sách những phần mềm ñó lại ñể sau này ngồi cài(như tôi thì việc cài lại phần mềm, driver mất khoảng 2 
tiếng trong khi cài ñè Win mất có 25 phút!) 

  
2.Các phần mềm tăng tốc: 
* Có rất nhiều phần mềm tăng tốc tự hào là có thể tăng tốc máy 200-300% nhưng nhiều trong số chúng lại 
chẳng ra gì(có thể nhà sản xuất chỉnh cho một cái máy chạy thật chậm chạp, tệ hại rồi dung phần mềm của 
mình “Optimize” lại ñể lấy ñiểm benchmark chăng?). 
 * Chú ý là không nên cài quá nhiều phần mềm, chỉ cài những cái gì thật cần thiết, nếu không máy bạn sẽ 
không những không chạy nhanh lên mà còn chạy chậm ñi, rồi lỗi tương thích.... 

  
a.Phần mềm tăng tốc cho Internet 
-Theo tôi hay nhất là phần mềm IE Accelerator 2.21 từng ñược nói ñến trên báo LBVMT. 
-Trình Download hạng nhất là Dap-thực ra chức năng Zip Preview mà tác giả bài HiDownload-phần mềm 
download số một nói ñến ñã có từ lâu ở Dap và nó còn nhiều chức năng tuyệt vời khác, nhưng quan trọng nhất 
là tốc ñộ download của nó ñược mọi người công nhận là rất nhanh. 
b.Phần mềm tăng tốc Windows: 
-Theo tôi thì nên dùng 2 phần mềm: Hare 1.5.1 và PC BoOster 3.0, phần mềm Speeder XP tuy về lý thuyết thì 
hay nhưng thực tế không hay lắm, tăng tốc hiệu quả với ít chương trình nên tôi không dùng. 
- Theo tôi thì trừ khi các bạn sử dụng máy tính xách tay còn không thì không nên dùng các chương trình 
“cooler” vì vừa tốn tài nguyên hệ thống vừa không ñem lại tác dụng rõ rệt, còn chuyện giảm phần trăm CPU thì 
không rõ là có làm chậm hệ thống không bởi vì các phần mềm tăng tốc như Hare và SpeederXp ñều cố gắng 
khai thác CPU tối ña. 
c.Driver:  
Chú ý ñặc biệt: Không phải bao giờ mới cũng là tốt hơn, lí do là: 
*Sự hỗ trợ của hãng với sản phẩm của mình, theo tôi thì hãng có sự hổ trợ tốt nhất với sản phẩm là Intel: 
chipset810/815 ñã có 6,7 năm rồi mà hãng vẫn cung cấp thông tin kỹ thuật cụ thể, driver của sản phẩm trên 
website trong khi Nvidia thì dòng Geforce 2MX400 mới có tầm hơn 3 năm thế mà năm ngoái tôi phải tìm mãi 
trên website của Nvidia mới thấy có vài dòng thông số kỹ thuật sơ sài. 
*Driver mới hơn thường phải ôm ñồm, VD: Detonator của Nvidia cứ lớn dần mỗi khi có thêm một phiên bản Gpu 
xuất hiện vì nó bao gồm Driver từ Geforce 256 ñến Geforce 4. Hậu quả là sẽ tốn tài nguyên của máy: tốn ñĩa 
cứng, tốn bộ nhớ. 
*Mỗi sản phẩm chỉ có một Driver cho tốc ñộ cao nhất và Driver ñó thường không phải là driver mới nhất, ñặc 
biệt là với TH của Nvidia. Có thể giải thích như sau: khi bắt ñầu tung ra thị trường một sản phẩm gì ñó, VD là 
Geforce 4 Ti 4600 thì hãng phải ra sức viết và tối ưu driver của mình sao cho ñạt ñiểm Benchmark cao nhất, ñủ 
sức mê hoặc người dùng, còn khi có sản phẩm mới thì họ lại dồn sức vào nó. 
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*Driver cho ñĩa cứng Intel Applicaption Accelerator ñi kèm Main. Lưu ý là chỉ những máy dùng chipset Intel mới 
dùng ñược. Chi tiết tôi sẽ trình bày trong phẩn sau: “Tiến hành”. 
d.Anti-virus, Fire wall: 
 ðây là những thứ không thể thiếu với một máy PC có kết nối Internet. 
*FireWall: với ngưòi dùng bình thường ở kết nối 56K thì có thể dùng tường lửa có sẵn của Win XP cho tiết kiệm, 
còn nếu là kết nối ADSL thì nên dùng một phần mềm chuyên nghiệp như Zone Alarm. 
*Anti-Virus: mặc dù nhiều người trong số chúng ta ñã chán ngấy Norton Anti-virus già nua và thử dùng nhiều 
phần mềm cạnh tranh khác và thấy chúng rất tuyệt nhưng phải nói rằng NAV vẫn là phần mềm chống virus 
hàng ñầu ñể chúng ta cài vào máy. Còn Bkav 2002 tuy không sánh ñược nhưng các bạn vẫn nên có, kể cả 
không cho nó autorun, thường trú cũng ñược bởi vì nó có ưu ñiểm là gọn nhẹ nên tải cập nhật virus mới rất 
nhanh. 
II/Tiến hành: 
1. ðĩa cứng: 
*Trước hết, nếu bạn dùng ñĩa cứng ATA 66/100/133 thì hãy kiểm tra và chắc chắn rằng cáp ñĩa cứng minh 
ñang dùng là loại 80 chứ không phải là 40 sợi rồi tiếp tục bước sau. 
*Nếu bạn dùng Win XP Pro hay Sp1 thì chắc chắn là bạn nên cài Intel Applicaption Accelerator thay cho sử dụng 
driver có sẵn của Microsoft vì nó sẽ cải thiện tốc ñộ rất ấn tượng : máy tôi trước khi cài nó, boot phải mất 5-6 
vạch chạy dưới logo WinXP, cài xong chỉ có 3 vạch thôi. 
*Khi tôi dùng Win XP Sp2 thì tôi không thấy có sự khác biệt nhiều về tốc ñộ, và WinXP SP2 là bản mới nên tôi 
cũng dùng driver của Microsoft ñể tránh xung ñột. 
2.CPU và RAM: 
a.CPU: 
-ðể ñảm bảo Cpu của bạn chạy với hiệu năng cao nhất, hãy vào CMOS setup ñể bật chế ñộ Turbo. Nó ñược gọi 
với nhiều cái tên khác nhau tùy thuộc vào phiên bản Bios và tùy hãng, VD như ở main GA-8IR533 thì gọi là ”Top 
performance”. 
-Về việc OverClock:  
-ðừng dùng phần mềm cấp cao trong Windows ñể Overclock vì nó làm cho hệ thống mất ổn ñịnh hơn nên mức 
OC bị giới hạn thấp. Hãy OC trực tiếp từ Bios hoặc với các máy cũ hãy OC bằng Jumper trên Main. 
-Nên nhớ ép xung CPU lên 1/5 thì cũng chưa chắc tốc ñộ hệ thống ñã tăng lên 1/10, tương tự như vậy nếu Cpu 
của bạn là 1,8 hoặc 2,0 mà bạn chỉ ép xung lên 200-300 Mhz thì khó mà cảm nhận ñược tốc ñộ. 
-Các loại Main khác nhau cho khả năng OC khác nhau. VD: main Intel hoàn toàn không thích hợp cho việc này, 
main Gigabyte 8IR533 OC không ñược cao lắm.... 
-Khi OC hãy chú ý ñến Ram: Trước ñây, muốn OC CPU người ta có hai cách: tăng hệ số nhân của chip và tăng 
tốc ñộ bus hệ thống, nhưng các chip Intel sau này ñã khóa hệ số nhân nên bạn chỉ có thể thay ñổi bus hệ 
thống<ñừng nhầm với FSB>. Nhưng khi thay ñổi bus hệ thống thì không chỉ Cpu mà các thành phần khác ñều 
bị ảnh hưởng, như bus PCI/AGP và cả Ram nữa. Nhưng với bus AGP/PCI thì phần OC trong CMOS có chức năng 
fix nên không bị chạy sai tốc ñộ <ñây cũng là một chức năng mà OC trong Windows không có >. Còn Ram, nếu 
Ram bạn là loại chạy ñược với tốc ñộ mới thì không sao <ví dụ: Ram là loại 333, trước ñây ñang chạy với tốc ñộ 
266 mà OC lên 309< 333 thì không vấn ñề gì>, nhưng nếu ép ram chạy quá tốc ñộ tối ña của nó thì coi chừng 
ram của bạn sẽ hỏng trước Cpu ñấy <hỏng Ram không có nghĩa là phải có khói bốc hoặc hoàn toàn không chạy 
ñược như CPU mà có thể chỉ là hỏng một ô nhớ nào ñó>. Vì vậy cứ mỗi bước OC xong mà khi chạy một chương 
trình nào ñó mà xuất hiện lỗi ILLEGAIL OPERATION <lỗi ở thanh ghi có ñịa chiXXXXX> thì hãy cẩn thận. 
b.Ram: 
-Có những chương trình ñược quảng cáo là tăng tốc cho Ram bằng cách dồn Ram hoặc Recover Ram. Theo tôi 
thì những chương trình như thế thì bạn không nên cài vào máy bởi vì tốn tài nguyên mà hiệu quả ñem lại không 
cao thậm chí còn làm chậm máy khi chơi trò chơi, chạy ứng dụng lớn. Ram là loại bộ nhớ cực nhanh nên cho dù 
có không defragment như ñĩa cứng cũng chẳng ảnh hưởng ñến tốc ñộ. Còn nếu bạn thấy cần dùng những 
chương trình như vậy hãy tắt chức năng auto-recover Ram nếu không muốn ñang nạp game thì bị thoát ra 
ngoài, xuất hiện cửa sổ dồn Ram rồi khi vào game thì mất tiếng, giật...Cuối cùng, trong những chương trình loại 
ấy tôi chỉ thích Hare với chức năng wash ram là thực sự hay vì sau khi dọn dẹp, nó lại load lại các service, driver 
hệ thống. 
3.Card ñồ họa: 
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-Một kinh nghiệm ñầu tiên là khi mua card ñồ họa bạn ñừng mua hàng ñộc hoặc ít phổ biến, hay nhất là Nvidia 
Geforce x nếu không muốn tiếc rẻ thèm thuồng trước những chương trình hay nhất mà chỉ hổ trợ hoàn toàn cho 
Nvidia Geforce. 
-Về OC:  
*Khi OC card ñồ họa, nhớ rằng Ram không phải là thứ có thể ép xung nhiều như Gpu. 
*Không phải card nào cũng cho khả năng và giới hạn OC như nhau. VD:Tăng tốc ñộ xung nhịp lên 15/100 thì ở 
nhiều loại card-như geforce 2 MX 400, cái bạn nhận ñược không phải là chỉ số fps tăng mà là treo máy, mất ổn 
ñịnh... 
*ðừng ñánh giá tốc ñộ làm ñầy của một card ñồ họa qua MHZ: Cái quan trọng là trong một xung nhịp nó có thể 
xử lý ñược bao nhiêu ñiểm ảnh, VD: từ thế hệ card Geforce 256 ñến geforce 4 TI 4600 thì có thể xử lý ñược 
bốn ñiểm ảnh/Hz nhưng với những card ñời trước hay ngay cả với một số loại chip ñồ họa tích hợp cùng thời thì 
không ñạt ñến con số này hay gần ñây từ Radeon 9700, Geforce FX 5800<thế hệ geforce FX ñầu tiên> con số 
này ñã ñạt ñến 8 ñiểm ảnh/xung nhịp. 
*Cần nói thêm, bản thân tốc ñộ lấp ñầy cũng chưa nói lên tốc ñộ của chip mà còn phải nói ñến băng thông bộ 
nhớ. Và cả hai thứ ấy có lẽ còn chưa ñủ ñể nói lên ñiều gì: Vd: hãy so sánh 3 card: Geforce 2 MX 400, Geforce 
2 Ultra và Geforce 3. Geforce 2 MX 400 và Geforce 3 có tốc ñộ làm ñấy ñều là 800 Mtexels/s còn Geforce 2 Ultra 
là 1 tỷ <250Mhz>. Geforce 3 và Geforce 2 Ultra có băng thông là 7,23 GB/s còn Geforce 2 MX 400 là 2,7. Trong 
nhiều thử nghiệm Geforce 2 Ultra cho kết quả nhanh gấp ñôi geforce 2 MX 400 nhưng lại thua xa geforce 3. 
*Trừ nForce 1/2/3 <chipset của Nvidia cho Main board AMD ñược tích hợp bộ xử lý ñồ họa Geforce, VD nforce 1 
tích hợp geforce 2 MX, nForce 2 tích hợp Geforce 4 MX> ra thì các chipset có tích hợp ñồ họa khác, kể cả Intel 
GMA 900 mới nhất cũng có ñiểm chưa sánh bằng Gpu cũ Geforce 256 là hỗ trợ khử răng cưa và quan trọng ñặc 
biệt là Hardware Transform and Lighting- vốn ñược rất nhiều game 1-2 năm gần ñây yêu cầu. 
*Tinh chỉnh ñồ họa không chỉ là chỉnh ñộ phân giải, ñộ chi tiết mà còn nhiều phần khác ñược ẩn trong driver 
như Z-buffer, fast linear-mipmap, texture compression...chỉnh chúng khác ñi so với mặc ñịnh có thể giúp nâng 
cao chất lượng hình ảnh một cách ñáng kể hoặc nâng cao hiệu năng nhiều. VD trong một game 3D vẫn ở ñộ 
phân giải ñó, thiết lập ñồ họa trong game như thế nếu bật tất cả các chức năng nâng cao chất lượng hình ảnh, 
kể cả chống răng cưa 4x thì tốc ñộ khung hình có khi chỉ là 25fps nhưng nếu bật các chức năng tăng tốc, tắt 
các chức năng hình ảnh thì tốc ñộ có thể lên tới 100 fps. 
*Nên dùng một công cụ Tweak <tinh chỉnh, OC card> như NV turbo, Geforce Tweaker Ultility, Nvmax, NV 
HardPage, hoặc hay nhất là Riva Tunner <tất cả ñều ở www.guru3d.com>. Chú ý ñừng sử dụng những chức 
năng giả lập card vì sẽ không có lợi về tốc ñộ. 
*Với 1 số trò chơi thì chơi trên Win 98 có thể nhanh hơn nhưng khi chơi trên Win XP thì số khung hình sẽ ổn 
ñịnh hơn. 
*Một số cài ñặt ñem lại tốc ñộ :Z-buffer, W-buffer, Floating point W-buffer 100/100, multi-texturing, linear 
mipmap filtering, HW accelerated cursor, 256 burst.... 
*Một số cài ñặt ñem lại chất lượng với tốc ñộ chấp nhận ñược: Lọc vô hướng 2x, Texture sharpenning, STC3 
quality bug fix.... 
4.Khởi ñộng, sử dụng công cụ tăng tốc: 
-Nếu có 2 trình Anti-virus thì chỉ ñể cho một trình chạy thường chú. 
-Cài ñặt ít chương trình tăng tốc, chỉ dùng những cái hiệu quả nhất. 
-Mở msconfig tắt bớt 1 số dịch vụ không cần thiết, bỏ một số chương trình chạy thường chú như Quicktime, 
Realone Tkbell.... 
-Cài ñặt xong hết các chương trinh mới chạy bootvis ñể rút ngắn thời gian khởi ñộng. 
-Nên chạy PC Booster 3.0, vào Auto tune page, nhấn Auto tune, làm theo hướng dẫn của nó... 
5.Bộ nhớ ảo: 
 Trước ñây người ta ñã ñưa ra công thức bộ nhớ ảo bằng dung lượng Ram*2,5. Nhưng bây giờ, dung lượng 
Ram nhiều rồi toàn từ 256-1G nên có lẽ không cần thiết lắm. Các bạn nên tùy vào bộ nhớ của mình mà ñặt file 
ảo cho khỏi tốn ñĩa cứng, bộ nhớ càng lớn thì file tạm càng không cần to. 
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CÁCH CÀI ðẶT FTP TRONG WIN 2K 

Có nhiều cách chuyển File hay chia sẽ file ( ta có thể chuyển file và chia sẽ file bằng software, hay 

chat Yahoo, gửi email nhưng có giới hạn về dung lượng file, vào tính bảo mật không cao) nhưng hôm 

nay tôi sẽ hướng dẫn các bạn cách chia sẽ file bằng  công cụ mà trong Windows 2k có sẵn.  

Chức năng của FTP: Ta có thể truy cập từ xa ñể chia sẽ dữ liệu qua internet bằng ñịa chỉ IP hay 

Domain. (Kích thước file không giới hạn , tùy thuôc vào ñường truyền internet của mình nhanh hay 

chậm, và tính bảo mật của windows) 

Các bước cài ñặt: 

• ðầu tiên ta cần phải thiết lâp IIS (Internet Information Services) hay (Internet Services 

Manager)  

o Nhấn Start\Settings\Control Panel\add Remove Programs --> hiện hôp thoại Hình 1 => chọn 

menu add Remove windowns Components => Hình2 chon IIS => Next (trong quá trình 

cài ñặt nó sẽ ñòi ta cho ñĩa win 2000 vào) sau khi cài ñặt xong ta làm bước kế tiếp  

.  

  

• Thiết lập cấu hình FTP  
o Start\Settings\Control Panel\Administrative Tools\ Internet Services Manager . Chọn Default FTP Site -

-> Action\Properties  
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•  Thẻ FTP Site:  
o IP Address: All Unassigned (nếu ta có card mạng thì chọn IP của cac mạng)  

o ở ñây tôi chọn ip cho minh là 192.168.0.1  

o Còn tất cả ta ñể mặc ñịnh.  



Sưu Tầm Thủ Thuật                                               traitimbinhyen_nova@yahoo.com 

http://vietdown.org                                                                                                   Nguyễn Anh Tú         

  
• Thẻ Security Accounts 

o Allow Anonymous Connections nếu ta chọn thì mac ñị cho mọi người vào ñều ñược.  
o FTP sate Operators : ta có thể Add thêm tên và mật mã ñể cho người nào minh cho phép vào 

(ta phải tạo user và pass)  
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• Thẻ Home Directory :  
o FTP Site Diretory: ta chỉ vào thư mục mà mình lưu trữ file cần chia sẽ (tôi ở ñây chia sẽ 

E:\Home FTP)  

o Xong bạn OK  

Như thế là ta ñã khai báo xong FTP. Bây giờ ta thử lại FTP coi có chạy tốt không bằng cách mở  

Internet Explorer Browser 

• ở phần ñịa chỉ ta gõ ftp://192.168.0.1/ nếu ta thấy nó mở ra ñúng mục Home FTP thì minh ñã thành công  

PHẦN KẾ TIẾP TA CÀI ðẶT SOFTWARE ðỂ ðĂNG KÝ IP. 
Vì sao ta phải cài ñặt software : " Vì mỗi khi ta vào mạng thì VNN hay FTP cung cấp cho ta 1 ñịa chỉ 
IP mới (IP ñộng) cho nên ta không thể nào biết ñược ip của mình là bao nhiêu khi connect vào mạng 

cho lần sau nên ta phài dùng software và 1 trang web (Free) dùng ñể trung chuyển cho người truy cập 

vào máy FTP của mình "  

• Bước ñầu tìên ta phải ñăng ký 1 Username trên trang web http://www.no-ip.com/ sau ñó ta vào phần ñăng ký 1 

Domain dưới dạng Tênbạn@no-ip.com , hay info...... sau khi ñăng ký xong ta load softwrae No-ipduc.Exe 
(http://www.no-ip.com/downloads.php?page=win)  

• Sau khi bạn Setup vào máy ở lần mở ñầu tiên bạn phải ñánh vào tên ban ñã ñăng ký và pass (tên 

dạng email của bạn)  
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• Sau khi ñăng nhập thành công ban ñược menu sau (bạn chọn vào vòng tròn ñỏ) khi thấy hinh 

mặt cười là bạn ñã ñăng ký thành công.  

 

• bây giờ minh muốn chia sẽ file với 1 người khác ở một nơi nào ñó (mặc ñịnh là ta ñang có 

trong internet) ta chỉ cần cung cấp Domain name ftp://tenban.no-ip.com/ và user & pass.  

Chúc bạn thành công. 
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CÁC TÍNH NĂNG KHÁ HAY CỦA GMAIL 

 
Gmail là một hộp thư khá tuyệt có dung lượng lớn 1GB . Do chỉ mới thử nghiệm nên chưa hoàn thiện lắm . Tuy 
nhiên với các tính năng ñộc ñáo sau sẽ khiến tôi cảm thấy rất ñáng khi phải bỏ thơì gian chờ ñợi và xin xỏ người 
khác tấm vé mời ( Invite ) sử dụng ñể có ñược một hộp thư Gmail . 
  
Nhanh hơn chuột 

• ðó là tính năng Keyboard Shortcut , bạn sẽ tiết kiệm ñược khả nhiều thời gian thay vì phải di chuyển và 
click chuột thì khi bạn ñã bật tính năng này , bạn chỉ cần nhấn phím hoặc một tổ hợp phím . ( có phải là 
nhanh hơn chuột không . )  
ðể bật chức năng này , bạn ñăng nhập vào hộp thư và nhấp chuột vào liên kết settings và chọn ô kiểm 
“Keyboard shortcuts On” và nhấn vào nút Save Changes ñể lưu lại cấu hình . 

 
• Danh sách phím tắt : 

 
• ðó là một vài phím tắt quan trọng và thường xuyên sử dụng . Bạn có thể tham khảo thêm danh sách 

phím tắt tại 
http://gmail.google.com/support/bin/answer.py?answer=6594&query=Keyboard&topic=&type=f   

Không vào nhưng vẫn biết có thư 
• Là một trong những tiện ích vừa ñược GMAIL cập nhật . GMAIL Notifier sẽ giúp bạn kiểm tra thư và 

thông báo cho bạn biết khi có thư mới . Chương trình này vẫn ñang thử nghiệm , chỉ tương thích với 
Win 2000 / XP . Download tại http://toolbar.google.com/gmail-helper/  . 
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• Sau khi cài ñặt GMAIL Notifier chạy thường trú trên khay hệ thống , Nhấp phải chuột vào biểu tượng 

của Gmail Notifier ( có hình bức thư ) chọn Check Mail Now ñể kiểm tra thư , View Inbox ñể mở hộp thư 
và Tell Me Again ñể nhắc lại lần nữa nếu bạn không ñược nhanh mắt vì hộp thoạI thông báo có thư của 
GMAIL Notifier xuất hiện và tắt ñi quá nhanh .  
Lưu ý : trong lần ñầu tiên sử dụng , Gmail Notifier bắt bạn ñăng nhập bằng tài khoản hộp thư Gmail , 
Phần User không có ñuôi @gmail.com . Nếu ñăng nhập thành công rồi thì trong những  
lần sau chương trình sẽ không còn bắt bạn ñăng nhâp nữa .  

 
Tìm kiếm thư cực nhanh 

• Với 1GB , bạn không còn lo sợ hộp thư bị ñầy nữa nên không cần phải xoá thư thường xuyên như trước 
nữa . Tuy nhiên nếu ngày càng nhiều thư thì thật khó quản lý và sắp xếp nhưng may thay Gmail có tích 
hợp chức năng tìm kiếm , vốn là một thế mạnh của Google . 

• Nhập từ khoá cần tìm và nhấp chuột vào nút Search Mail . kết quả sẽ ñược trả về ngay lập tức ( sử 
dụng ñường truyền ADSL ) . 
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• Sau ñây là danh sách một số các từ khoá thông dụng ñể việc tìm kiếm ñạt kết quả chính xác hơn Xem 

thêm danh sách từ khoá tại : 
http://gmail.google.com/support/bin/answer.py?answer=7190&query=Advanced&topic=&type=f  

 
 
 
 
 
 
 
 

CÁC LỖI THƯỜNG GẶP ðỐI VỚI MODEM 
 
 
 

1.  Modem và line ñiện thoại: 

Modem bị chiếm dụng bởi chương trình khác : báo lỗi  " Error 602: The modem is being used by 

another Dial-Up Networking connection close the   other connection,anh try again "  

-Nguyên nhân: Modem bị chiếm dụng bởi chương trình như  Winfax, chương trình Media Pilot  (ñối với máy 

Compaq). . .  

-Cách khắc phục : Thoát khỏi các chương trình ñang chiếm dụng Modem .  
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Máy Detect ñược Modem nhưng khi quay số báo ?No dial tone? có thể do các trường hợp sau:  

-Nguyên nhân : ðường dây ñiện thoại không tiếp xúc tốt ,lỗi Modem hư .  

-Cách khắc phục: Kiểm tra lại ñường dây ñiện thoại và Modem.  

Máy không Detect (không nhận dạng ñược Modem).  

-Nguyên nhân:  

+ Cable nối từ Modem ñến máy tính tiếp xúc không tốt. 

+ Cable nối cổng COM tiếp xúc không tốt hoặc cổng COM máy tính hư.  

+ Khắc phục: Kiểm tra cable Modem và Cable nối cổng COM (gắn chặt vào).  

Không kết nối vào mạng ñược . Báo lỗi: ?There is no anwer. An error occourred while establishing the Dial 

Up network connection ?VNN? hoặc ?Unable to establishing Dial Up Network connection. Please go to ?Dial Up 

networking and make sure your connections are configed property.?  

-Nguyên nhân: ðường dây ñiện thoại không tốt hoặc do chương trình cài ñặt Modem lỗi.  

-Cách khắc phục:  

+ Kiểm tra ñường dây ñiện thoại. 

+ Xóa và cài lại Modem.   

2.  Lỗi  do chương trình: 

Không tạo biểu tượng kết nối ñược: báo lỗi ?error rundll32??.  

-Nguyên nhân: Do trong quá trình cài Folder Dial-up Networking trên windows sai phiên bản.  

-Cách khắc phục: Cài lại Folder Dial-up Networking ñúng phiên bản Windows mà bạn ñang 

chạy.    

Quay số kết nối vào ñược nhưng khi ñến trạng thái ?verify username and pasword ? báo ? 

uncompatible protocol??.  

-Nguyên nhân: Do thiếu giao thức TCP/IP .  

-Cách khắc phục: Cài thêm TCP/IP vào.  

Kết nối vào mạng ñược nhưng không nhận ñược mail.  

-Nguyên nhân: 

+ Mật khẩu mail sai. 

+ Sai thông số Incoming  Mail server (POP3)  

-Khắc phục: 

+ Gõ lại mật khẩu thư. 

+Tắt chế ñộ gõ chữ Việt. 

+ Khai báo lại thông số Incoming  Mail server (POP3): mail.hcm.vnn.vn  

Kết nối vào mạng ñược nhưng không gửi ñược mail.  
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-Nguyên nhân: Sai thông số Outgoing Mail Server(SMTP)  

-Khắc phục: Khai báo lại thông số Outgoing Mail Server(SMTP): smtp.hcm.vnn.vn   

Không kết nối vào mạng . Báo lỗi: ?Error 691 : The computer you?re dialing into cannot establish a 

Dial up networking connection Check you password and then try again?  

-Nguyên nhân: Sai mật khẩu truy nhập  

-Khắc phục: Giải quyết giống như sai mật khẩu thư, Nếu như bạn bạn không thể nào kết nối 

ñược mạng thì bạn yêu cầu ISP cấp lại mật khẩu mới.   

Kết nối vào khoảng 10 ñến 15 phút thì ngắt khỏi mạng  

-Nguyên nhân: ðường dây ñiện thoại của bạn bị nhiễu hoặc Modem của bạn ñể tốc ñộ kết 

nối quá thấp.  

-Khắc phục:  

+Thử kết nối bằng ñường dây ñiện thoại khác.  

+Tăng tốc ñộ Modem có thể kết nối lớn nhất (trong phần chỉnh sửa các thông số của biểu   

tượng kết nối )  

+ Chú ý: Nếu bạn tăng tốc ñộ quá cao có thể Modem không quay số kết nối vào mạng ñược 

lúc ñó  bạn có thể giảm tốc ñộ thấp xuống bớt.  

Lỗi 664: The system has run out of memory  

-Nguyên nhân: Máy tính của bạn không ñủ bộ nhớ ñể quay số kết nối.  

-Khắc phục: tắt một số chương trình ñang mở và quay số lại.   

Lỗi 666:The modem is not functioning  

-Nguyên nhân: Modem hoặc một số thiết bị khác không ñáp ứng, có thể do một số nguyên 

nhân sau:  

+Nếu nguồn cung cấp Modem(External).  

+Cáp nối giữa Modem và cổng Com máy tính.  

+Lỗi do phần cứng của Modem.  

-Khắc phục:  

+Kiểm tra cáp nối giữa Modem và cổng Com máy tính.  

+Tắt nguồn Modem khoảng 15-20 giây rồi bật lại.   

Lỗi 668: The connection was terminated  

-Nguyên nhân: tương tự lỗi  652.  

-Khắc phục: tương tự như lỗi 652.   
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Lỗi 676: The phone line is busy.  

-Nguyên nhân: Dây ñiện thoại bị bận.  

-Khắc phục: Cần kiểm tra ñường dây ñiện thoại, và thử kết nối lại (Redial). Ban có thể cài ñặt 

cho máy tự ñộng gọi lại bằng cách vào phần Options của phần Properties của Connections.   

Lỗi 678: There was no answer  

-Nguyên nhân: Không có trả lời từ line ñiện thoại.Modem của bạn không lấy ñược tín hiệu 

Tone của ñường dây ñiện thoại.  

-Khắc phục: Kiểm tra xem line ñiện thoại ñã ñược cắm vào modem chưa, kiểm tra lại số ñiện 

thaọi cần gọi (1260) và gọi lại. Cần chắc chắn là line ñiện thoại ñược cắm vào ñúng lỗ cắm 

trên modem (lỗ Line).  

Lỗi 679: The system could not detect the carrier  

-Nguyên nhân: Modem của bạn hay modem ở xa không trả lời. ða số modem trả về lỗi này 

trong trường hợp modem trả lời không trả lời.  

-Khắc phục:Bạn kiểm tra lại số ñiện thoại và gọi lại.   

Lỗi 680: There was no dial tone  

-Nguyên nhân: Không có tone của line ñiện thoại.Lỗi này thường xảy ra cho các modem sử 

dụng line ñiện thoại của tổng ñài nội bộ; khi ñó ñể gọi ra ngoài, bạn cần có số 9 trước ñể lấy 

tone của line ñiện thoại ngoài.  

-Khắc phục: bạn cần kiểm tra xem ñã nối line ñiện thoại và modem ñã ñúng chưa. Nếu bạn 

trong hệ thống tổng ñài nội bộ, cần có thêm dấu phẩy (,) sau số 9 ñể có thời gian trễ cho 

việc lấy tone line ñiện thoại ngoài.   

Lỗi 691: Access was denied because the use name and/or password was invalid on the domain  

-Nguyên nhân: Account của bạn có thể chưa ñược khai báo bởi hệ thống, hoặc do password 

của bạn bị hết hạn sử dụng, hoặc do bạn gã bị sai Password.  

-Khắc phục:Cần hết sức chú ý khi gõ Password. Chú ý chế ñộ tiếng việt của hệ thống 

Windows của Bạn có thể làm cho Password của bạn bị sai.   

Lỗi 692: There was a hardware failure in the modem  

-Nguyên nhân: modem của bạn hoặc modem ở xa không trả lời do các lỗi sau:  

+Modem của bạn ñang tắt, bị trục trặc, hoặc chưa ñược nối vào máy tính  

+Cổng serial (COM) của bạn bị lỗi.  
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+Một chương trình khác hiện ñang chiếm giữ Modem (ví dụ như chương trình HyperTerminal 

hay WinFax)  

-Khắc phục:  

+ Reset lại modem, kiểm tra lại các dây nối cổng COM  

+Nếu có chương trình khác ñang chiếm giữ modem của bạn, hãy tắt (Close) các chương trình 

này.   

Lỗi 695: The state machine are not started  

-Nguyên nhân: Một lỗi bên trong của Windows ñã xảy ra.  

-Khắc phục: bạn hãy tắt và khởi ñộng lại máy tính ñể chắc chắn là các driver và các cấu hình 

ñều ñã ñược khởi ñộng và có hiệu ứng.   

Lỗi 696: The state machine are already started.  

Tương tự lỗi 695   

Lỗi 697: The response looping did not complete  

Tương tự lỗi 695   

Lỗi 699: The modem responese caused a buffer overflow  

Tương tự lỗi 695   

Lỗi 701: The modem moved to a connection speed not supported by the COM driver.  

-Nguyên nhân: modem của bàn ñang cố gắng kết nối ở tốc ñộ mà cổng COM không thể ñáp 

ứng ñược.  

-Khắc phục: Bạn hãy thay ñổi tốc ñộ khởi ñộng modem về tốc ñộ thấp hơn.   

Lỗi 710: Serial overrun errors were detectd while communicating with the modem  

-Nguyên nhân: lỗi xảy ra khi cổng Serial cố gắng kết nối với modem  

-Khắc phục: giảm tốc ñộ khởi ñộng xuống thấp hơn.   

Lỗi 715: Too many errors occurred because of poor phone line quality  

-Nguyên nhân: Quá nhiều lỗi xảy ra do chất lượng line ñiện thoại quá kém.  

-Khắc phục:kiểm tra lại chất lượng line ñiện thoại và thửu gọi lại. Nếu vần xảy ra lỗi, giảm tốc 

ñộ của Modem xuống thấp hơn.   

Lỗi 728: The system cannot find an IP adapter  

-Nguyên nhân: lỗi xảy ra với cấu hình TCP/IP của máy  

-Khắc phục: kiểm tra lại TCP/IP, khởi ñộng lại máy ñể chắc chắn là các cấu hình ñã ñược khởi 

ñộng và có hiệu ứng. Nếu lỗi vẫn xảy ra, xoá TCP/IP và cài ñặt lại.   
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Lỗi 756: The connection is already being dialed.  

-Nguyên nhân: line ñiện thoại ñang bận, ñang kết nối  

-Khắc phục: chờ và quay lại sau ñó.   

3.  Một số lỗi thông báo trên màn hình khi kết nối và khi sử dụng:  

Lỗi 630 : The Modem was disconnected due to hardware failure.  

-Nguyên nhân: có thể do một số nguyên nhân sau:  
+Cáp nối giữa modem và cổng COM tiếp xúc không tốt hoặc các thiết bị liên lạc thông tin khác.  
+Cổng COM hỏng.  
+Modem.  
-Khắc phục:  
+Kiểm tra lại cáp nối giữa modem và cổng COM của máy tính.  
+Kiểm tra cổng COM và Modem   
Lỗi 633: The Modem is already in use or not configured for dialing out.  

-Nguyên nhân: Modem bị chiếm dụng bởi chương trình khác ví dụ: Win Fax Pilot hoặc chưa thiết lặp cấu hình 
quay số.  
-Khắc phục: Tắt các chương trình ñang chiếm dụng Modem.  
Lỗi 636:The device attached to the port is not the one expected.  

-Nguyên nhân: Sự không nhất quán giữa cấu hình phần cứng và cằi ñặt các thông số  kết nối trên máy bạn. Ví 
dụ: khi bạn cáp Modem lắp vào cổng COM2, trong khi ñó khi cài ñặt các thông số Modem bạn lại chọn cổng 
COM1, COM3 hoặc COM4.  
-Khắc phục: cài ñặt lại ñúng cấu hình ñã lắp ñặt  
Lỗi 651:The modem has reported an error.  

-Nguyên nhân: Modem(External) của bạn chưa cấp nguồn.  
-Khắc phục: tắt / bật nguồn Modem và kết nối lại.   
Lỗi 652 :There was an unrecognized response from the modem.  

-Nguyên nhân: có thể do 1 trong 2 nguyên nhân sau:  
+Nếu Modem của bạn ñang dùng loại External có thể chưa cấp nguồn.  
+Tốc ñộ khởi tạo của modem quá lớn (Maximum modem port speed).  
-Khắc phục:  
+Tắt / bật nguồn Modem.  
+Giảm bớt tốc ñộ modem (Control panel/Modem/Properties) ví dụ: 115200 æ 57600.   
4.  Lỗi do chương trình Mail: 

Lỗi : Chương trình Outlook Express báo lỗi tập tin Msimnui.dll ?This program has performed an 

illegal operation and will be shut down. If the problem persists, contact the program vendor? và 

khi bạn nhắp chuột vào chữ Details thì bạn nhận ñược thông tin sau: ?MSIMN caused an invalid 

page fault in module MSIMNUI.DLL at <address>.?  

-Nguyên nhân: là do bạn cài ñặt phần mềm Outlook Express với một phiên bản cũ hơn phiên bản hiện có trước 
ñó trên máy của bạn.  
-Cách khắc phục:  
*Cách thứ nhất.    
+Cơ bản nhất ñể khắc phục sự cố này là bạn xóa bỏ chương trình Outlook Express trong máy của bạn và cài ñặt 
một chương trình Outlook Express mới với Version cao hơn              
*Cách thứ hai. 
 Bạn tìm và xóa bỏ các tập tin sau *.idx, *.mbx, *.nch. ðể hực hiện ñược ñiều ñó bạn làm như sau :  
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+Bạn kích chuột vào chữ Start ->Find ->Files or Folders. Trong ô Named bạn gõ *.idx và trong ô Look in bạn 
chọn ổ ñĩa C. Sau ñó bạn click chuột vào chữ Find . Máy tìm ra cho bạn một số tập tin có ñuôi là .idx bạn xóa 
tất cả ñi. Bạn tiếp tục lập lại các bước trên ñối với các tập tin có ñuôi dạng *.mbx và *.nch.   
Lưu ý: Trong tất cả các cách hướng dẫn dưới ñây ñều có thể làm mất ñi những bức thư cũ của hộp thư trong 
máy tính của bạn. Vì vậy bạn nếu bạn muốn giữ lại những bức thư ñó thì bạn phải copy inbox lại.    
Lỗi : Chương trình Outlook Express bị treo máy khi bạn gửi và nhận mail. Khi bạn dùng Outlook 

Express nếu bạn soạn thư xong và bấm vào nút send ñể gửi thư ñi thì ñột nhiên máy của bạn bị 

treo và bạn phải khởi ñộng (Restart) lại máy sau ñó mới gửi ñi ñược.  

-Nguyên nhân: Chọn sai biểu tượng quay số kết nối vào mạng.  
-Khắc phục tình trạng này bạn làm như sau:  
+Trên chương trình Outlook Express bạn nhắp vào menu:  Tools -> Options -> Send. Trong hộp thoại bạn sẽ 
thấy dòng chữ nhắp  bỏ chọn trong ô: Send messages immediately  -> OK.    
+Tiếp theo bạn vào cửa Click chuột vào trở lại vào chữ Tools->accounts ->Mails. Chọn Account VNN ( thường là 
dòng Mail.hcm.vnn.vn) -> Properties->Connections. Trong hộp thoại, bạn kiểm tra chương trình mail giống như 
hình dưới ñây không?  
+Lỗi ñã kết nối vào Internet nhưng khi nhắp nút Send and Receive thấy xuất hiện hộp thoại  
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     hoặc sau khi ấn nút Cancel thấy xuất hiện hộp thoại sau ñây: 
  

 
-Nguyên nhân :  
+ Sai tên truy cập vào hộp thoại maill.  
+Sai mật khẩu mail.  
-Khắc phục: kiểm tra tên và mật khẩu vào hộp thư.  
Chú ý:  Tên và mật khẩu truy cập vào hộp thư ñều phải phân biệt chữ in hoa và chữ in thường. 
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BIẾN MÁY BẠN THÀNH INTEL PENTIUM IV 

 
Nếu máy bạn thuộc lọai máy” con nhà nghèo” nhưng bạn vẫn có thể tự hào khoe với bạn bè mình máy bạn 
thuộc cỡ Pentum IV thì với thủ thuật nhỏ sau ñây sẽ biến “giấc mơ ñó thành sự thật”  
  
ðối với Win9x  

• Bước 1: Bạn mở trình sọan thảo Notepad 
o Bạn ñánh dòng lệnh sau ñây: 

� REGEDIT4  
[HKEY_LOCAL_MACHINE\Hardware\Description\System\CentralProcessor\0]  
"VendorIdentifier"="Intel Pentium IV CPU: 3.4 GHz"  
"Identifier"="Only Power Of Intel" 

• Bước 2: Bạn lưu ñọan lệnh ñó dưới dạng .reg (ví dụ : IntelP4.reg ) tiếp theo bạn tạo một Shortcut của 
file bạn vừa lưu vào di chuyển nó vào thư mục Startup trong Windows. 

• Bước 3 : Trong thư mục Startup bạn chọn tập tin mà bạn vừa Move vào và chọn Tab shortcup chọn 
target và biên sọan với nội dung :  

o REGEDIT.EXE /s c:\Mydocuments\ IntelP4.reg (ở ñây lệnh này có nghĩa là mỗi lần bạn khởi 
ñộng máy file có ñuôi .reg này sẽ tự kích họat một cách âm thầm và không ai có thể biết ñược, 
ñường dẫn trong c:\Mydocuments\ IntelP4.reg là ñường dẫn nơi và tên bạn lưu tập tin ñó) 

ðối với WinXp  
• Bạn cũng mở trình sọan thảo và biên sọan nội dung sau:  

o Windows Registry Editor Version 5.00  
[HKEY_LOCAL_MACHINE\HARDWARE\DESCRIPTION\System\CentralProcessor\0]  
"VendorIdentifier"="Intel Pentium IV CPU: 3.4 MHz"  
"Identifier"="Only Power Of Intel" 

• Các bước sau thì bạn cũng làm tương tự như trên 
Sau khi làm xong tất cả các bước tương ứng với Windows của máy bạn thì bạn chỉ việc khởi ñộng máy lại và vào 
Systems Properties ñể xem thành quả lao ñộng của mình, chúc các bạn thành công và có ñược một cấu hình 

máy như ý. 
 
 
 
 

BIẾN CHỮ START TRÊN WINDOWS XP THÀNH TÊN GỌI TÙY THÍCH 
 

Bài viết này tôi sẽ giới thiệu một thủ thuật nhỏ mà bạn có thể ñặt tên gọi tùy ý cho nút “Start” trên Windows 
XP. ðiểm hay của thủ thuật này là nút “Start” mới tạo ra không bị giới hạn chỉ trong 5 ký tự như một số cách 
làm khác  
 
Lưu ý trước khi thực hiện:  

• Thủ thuật này chỉ ứng dụng cho Hệ ñiều hành Windows XP phiên bản Professional và Home.  
• Tập tin mà thủ thuật này sử dụng là “explorer.exe” tại thư mục C:\Windows (C: là phân vùng ổ ñĩa cài 

ñặt hệ ñiều hành Windows XP). Bạn nên sao lưu lại tập tin này với một tên mới (ví dụ: ExBackup.exe) 
vào cùng thư mục này ñể dùng khi cần thiết.  

• Windows XP của bạn phải sử dụng giao diện chuẩn mặc ñịnh là Windows XP (themes) thì thủ thuật thay 
ñổi này mới có hiệu lực. ðể thiết lập giao diện chuẩn này bạn vào Desktop\ Properties\ chọn tab 
Themes và duyệt ñến theme “Windows XP”. Bạn cũng có thể chọn giao diện chuẩn ñể hiển thị kết quả 
sau khi thực hiện hoàn tất thủ thuật này.  

THỰC HIỆN  
• Bước 1: Tải về phần mềm Resource Hacker  

 
- Thực hiện thủ thuật này bạn sẽ cần ñến một công cụ biên tập ñặc biệt ñó là Resource Hacker ñể hiệu 
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chỉnh tập tin “explorer.exe” trong WindowsXP. ðây là một phần mềm miễn phí dùng ñể xem, hiệu 
chỉnh, thay ñổi tên, thêm xóa... các tập tin nguồn (*.res) và các tập tin thực thi (*.exe, *.dll, *.cpl, 
*.ocx...) trên các ứng dụng Windows 32 bits (từ Win95 ñến WinXP).  
 
Resource Hacker phiên bản hiện tại là v3.4.0 (dung lượng 540 KB), bạn có thể tải về các ñịa chỉ  
http://delphi.icm.edu.pl/ftp/tools/ResHack.zip  hay 
http://www.users.on.net/~johnson/resourcehacker/reshack.zip   
 
Cũng cần tải tập tin hướng dẫn sử dụng (dung lượng 115 KB) tại:  
 
http://www.users.on.net/~johnson/resourcehacker/reshack_hlp.zip   
 
- Sau khi tải phần mềm xong, bạn giải nén tập tin ResHack.zip vào một thư mục nào ñó trên ổ ñĩa cứng 
và chọn tập tin “ResHacker.exe” ñể thực hiện thủ thuật này. Phần mềm này tự chạy, không cần phải cài 
ñặt  
  

 
• Bước 2: Chỉnh sửa tập tin “Explorer.exe”  

o Bạn vào File\Open và mở tập tin “explorer.exe” tại thư mục C:\Windows\.  
o  Chọn thư mục “String Table”. Nhắp chuột vào dấu “+” phía trước “String Table” hay nhắp kép 

vào “String Table” ñể mở rộng thư mục này.  

 
  

o Duyệt ñến mục “37” và chọn mục “1033”, bạn sẽ thấy màn hình mới hiện ra như hình 3 (phần 
A) 

o  ðến ñây, bạn sẽ thay ñổi chữ “Start” (tại dòng 578 ñược ñánh dấu như trong hình 3 phần A) 
bằng một chữ nào ñó tùy ý bạn. Ở ñây tôi sử dụng tên ví dụ là “Quan tri mang” thay cho chữ 
“start” bằng cách quét chọn chữ hay nhắp kép chuột lên chữ “start”. 

o  Lưu ý:  
� 1/ Bạn không ñược xóa ñi dấu nháy kép mà chỉ thay thế phần chữ bên trong dấu nháy 
kép thôi (xem hình 3 phần B); 2/ Bạn có thể ñặt một tên mới bao gồm cả khoảng trắng 

và ký tự ñặc biệt như: ! @ # $.  
 

 
� So sánh hình 3 phần A (bên trên) và phần B (bên dưới) bạn sẽ thấy sau khi nhập vào 

chữ “The Gioi @” hay bất kỳ chữ nào khác thì nút “Compile Script” (bị mờ ñi trong phần 
A) ñã ñược tô ñậm lên ñể bạn chấp nhận thay ñổi (ñậm lên trong phần B). Nếu bạn ñã 



Sưu Tầm Thủ Thuật                                               traitimbinhyen_nova@yahoo.com 

http://vietdown.org                                                                                                   Nguyễn Anh Tú         

ñồng ý với chữ vừa thay thế, bạn phải nhắp vào nút “Compile Script” này thì thay ñổi 
mới có hiệu lực.  

� Bạn sẽ lưu lại tập tin này với một tên mới tại thư mục C:\Windows bằng cách chọn từ 
trình ñơn File\ Save As (xem hình 4).  

 

 
� Lưu ý: 1/ Bạn phải nhập vào tên mới với cả phần mở rộng là “.exe” (ở ñây tôi dùng tên 

tập tin là “quantrimang.exe”); 2/ Quy cách ñặt tên tập tin: Không ñược dùng các ký tự 
ñặc biệt hay khoảng trắng; 3/ Bạn không nên lưu lại trùng với tên “explorer.exe” bằng 
cách dùng phím tắt Ctrl + S hay từ trình ñơn File\ Save; 4/ Bạn có thể vào thư mục 
C:\Windows ñể kiểm tra lại tập tin mới này có cùng thuộc tính và dung lượng với tập tin 
“explorer.exe” ban ñầu hay không.  
  

• Bước 3: Chỉnh sửa Registry  
o Sau khi hoàn tất thay ñổi tên gọi cho chữ “start”, bạn phải ñăng ký với Registry ñể Windows XP 

nhận biết ñược thay ñổi này của bạn khi khởi ñộng máy tính.  
o Bạn vào trình ñơn Start\ Run, nhập vào “Regedit” (không có dấu ngoặc kép) và nhấn Enter hay 

nút OK trên hộp thoại này, màn hình Registry Editor sẽ hiện ra. Tiếp theo, bạn duyệt ñến thư 
mục Winlogon theo ñường dẫn sau: 
[HKEY_LOCAL_ MACHINE\SOFT WARE\Microsoft\ Windows NT \ CurrentVersion\ Winlogon]  

o Bạn chọn ñến khóa Shell trong khung màn hình bên phải.  
o Tiếp theo, bạn nhắp kép vào khóa Shell (khóa ñược tô sáng trong màn hình bên phải) ñể mở 

hộp thoại “Edit String”. Trong ô dữ liệu Value data, bạn nhập vào tên tập tin mới mà bạn ñã 
thay ñổi là “quantrimang.exe” như ở bước 2 trên ñây, và nhắp OK.  

o Sau khi hoàn tất bước cập nhật trên ñây, tập tin “explorer.exe” ñã ñược ñổi thành 
“quantrimang.exe”, xem hình 5 phần B.  
  

•  
o  Kết thúc bước 3 này, bạn ñóng màn hình Registry và khởi ñộng lại máy tính thì thủ thuật thay 

ñổi này mới có hiệu lực.  
Lưu ý sau khi thực hiện thủ thuật này:  
 
1/ Nếu khởi ñộng máy tính rồi mà chữ “start” vẫn còn xuất hiện trên menu Windows, bạn hãy kiểm tra lại xem 
giao diện Windows mà bạn ñang dùng có phải là giao diện chuẩn mặc ñịnh không (Windows XP theme). Nếu 
không ñúng thì bạn thực hiện thay ñổi giao diện như lưu ý trong phần ñầu của thủ thuật này.  
 
2/ Trường hợp bạn khởi ñộng lại máy tính mà màn hình không xuất hiện gì cả, bạn sẽ thực hiện khắc phục sự 
cố không mong muốn này như sau:  
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• Nhấn tổ hợp phím nóng “Ctrl+Alt+Del” ñể vào Windows Task Manager.  
• Bạn vào File\New Task (Run...) (chức năng tương tự như bạn vào Start\Run) và nhập vào “regedit” ñể 

mở tập tin Registry, sau ñó nhấn Enter hay phím OK trên hộp thoại này.  
• Thực hiện giống như bước 3, nhưng lần này bạn cho giá trị trong ô dữ liệu Value data trở về giá trị ban 

ñầu của nó là “explorer.exe” (hay là “ExBackup.exe” như ví dụ trong phần lưu ý ñầu tiên của thủ thuật 
này).  

• Hoàn tất chỉnh sửa Registry xong, bạn trở lại Windows Task Manager vào tab Shut Down\ Restart ñể 
khởi ñộng lại, máy tính của bạn sẽ trở về trạng thái ban ñầu.  

3/ Trong Process (vào Task Manager và chọn tab Process) trên máy tính bạn xuất hiện tập tin 
“quantrimang.exe” ñang ñược hoạt ñộng. Bạn cũng ñừng ngạc nhiên và bạn cũng ñừng kết thúc khi thấy 
Process này xuất hiện nhé! Nếu bạn kết thúc (End Process) này thì Windows của bạn sẽ mất ñi trình “Explorer” 
và sẽ không hoạt ñộng bình thường. Giải thích cho sự xuất hiện này là vì bạn ñã thay ñổi “explorer.exe” bằng 
tập tin “quantrimang.exe” khi thực hiện chỉnh sửa Registry ở bước 3 trên ñây.  
 
Chúc bạn thành công! 

 
 
 
 

BÍ KÍP KHAI THÁC LẠC VIỆT MTD 2002 
 

Lạc Việt từ ñiển là một bộ từ ñiển khá thông dụng , ñược sử dụng trong hầu hết các máy tính văn 
phòng trong nước . Mọi người ñều dùng Lạc Việt MTD trong công việc tra cứu của mình . Tuy nhiên , không 
phải ai cũng biết khai thác ñược các tính năng của bộ từ ñiển ña năng này . Bài viết này xin giới thiệu vài chiêu 
tận dụng các tính năng sẵn có của Lạc Việt MTD . 

  
Chiêu thứ nhất : ðọc văn bản bằng cả tiếng Anh lẫn Việt  

• Chiêu này rất thích hợp cho các vọc sĩ cần luyện nghe -  nói bằng tiếng Anh hay các ông “ tây “ muốn 
học tiếng việt của chúng ta .  

• Vào Menu Tools > Listening . Hộp thoại Listening hiện ra ( hình 1 )  , Bạn gõ nội dung cần ñọc vào 
khung text sau ñó chọn ngôn ngữ thích hợp bằng cách bấm vào một trong các nút chọn Vietnamese và 
English trong phần languages . Ngoài ra , bạn có thể chỉnh lại âm lượng ( Volume ) , tốc ñộ ( rate ) , 
cường ñộ ( Pitch ) bằng cách kéo các thanh tương ứng trước khi chọn Play ñể bắt ñầu nghe .  

o Lưu ý :  
� ðể phát âm ñúng Tiếng Việt  , khi gõ ,  bạn nên dùng bộ gõ tiếng việt Built In của lạc 

Việt MTD bằng cách ñánh vào nút Vietnamese , chọn kiểu gõ Vni hay telex . vì nếu sử 
dụng các bộ gõ khác như vietkey hay Unikey , bạn có thể sẽ bật cười Vì bất ngờ trước 
cách ñánh vần rất “ngố” của nhân vật trong từ ñiển .  

� ðể thay ñổi giọng ñọc khác , chúng ta vào menu tools > options , chuyển ñến thẻ voice 
( hình 2 ) ,Sau ñó , chọn lại giọng ñọc trong danh sách thả xuống trong phần voice rồi 
nhấn Ok ñể thay ñổi có hiệu lực  
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Chiêu Thứ hai : Tạo bộ từ ñiển mới cho chính bạn .  
  
    Với Lạc Việt MTD 2002 , bạn có thể quản lý , xóa , chỉnh sửa hay tạo thêm cho mình một bộ từ ñiển chuyên 
môn không thua kém các bộ từ ñiển sẵn có ( chỉ có ñiều , hơi bị cực một tí thôi ) . Bạn có thể làm ñược những 
ñiều ấy trong hộp thoại quản lý từ ñiển ( Tools > Dictionary managerment ) . 
  
Trong bài này , xin trình bày bạn cách tạo thêm một bộ từ ñiển mới . 
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o Trước tiên , bạn bật hộp thoại quản lý từ ñiển trong Menu Tools > Dictionary managerment . Sau ñó 
nhấn vào nút Create … ñể tạo một từ ñiển mới .  

o Trong hộp thoại Create a Dictionary , bạn ñiền ñầy ñủ các thông số như Tên tập tin ( File name , không 
cần gõ phần ñuôi mở rộng ) , Tiêu ðề Tiếng Việt ( Vietnamse Title ) , Tiếng Anh ( English Title ) , Tác 
giả ( Author ) , nhà xuất bản ( Publisher) . Trong phần Type Of dictionary , bạn chọn loại từ ñiển tương 
ứng hoặc chọn Other rồi nhấn Ok ( hình 3 ) . Lạc Việt MTD 2002 sẽ giúp bạn tạo một tập tin có dạng 
tentaptinbandachon.dit nằm trong thư mục Data  trong thư mục cài ñặt của MTD . ðây chính là mã 
nguồn của bộ từ ñiển mới của bạn . Bạn có thể copy tập tin này và ñem phổ biến hoặc tặng cho bạn bè 
.  

 

o Vừa tạo xong , từ ñiển của bạn dĩ nhiên là chẳng có gì cả . Vì thế bạn cần bổ dung thêm từ vào cho nó 

bằng cách chọn ñến tab từ ñiển của bạn trong cửa sổ  chính và nhấn vào nút   ñể thêm từ mới 
vào trong từ ñiển của bạn . Hộp thoại Add an Entry xuất hiện ( hình 4 ) , bạn ñiền từ cần thêm vào Ô 
New Entry rồi nhấn Ok ñể ñến bước tiếp theo  

 
  

o ðến cửa số MTD Editor ( hình 5 ) , các mục cần ñưa vào nội dung từ ñiển ñược liệt kê theo thứ tự trên 
thanh liệt kê nằm bên trái của màn hình Editor. Trong ñó có các mục :  

• Phonetic Transcription :  Phiên âm quốc tế của từ  
• Other Spelling : Cách viết khác của từ  
• Parts Of Speech : Từ loại : danh từ , ñộng từ , tính từ …  
• Meanings : Nghĩa  
• Examples : Ví dụ  
• Idioms : Thành ngữ  
• Examples for Idioms : Ví dụ thành ngữ  
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• Normal text : văn bản bổ sung thêm vì thông thường mục nhập nghĩa trong MTD bị giới hạn số 
lượng từ  

• Multimedia : Chèn thêm tư liệu , hình ảnh  , âm thanh  
• Rich Text Format : RTF tương tự như Normal text nhưng có thêm nhiều tính năng như in 

nghiêng , in ñậm , ñổi màu chữ , ñổi phông …  
• Move up , move down : Di chuyển , sắp xếp lại thứ tự trình bày của các mục .  
• Remove Entry : xóa mục này .  
• Close : thoát khỏi MTD Editor .  

  
Bạn chọn mục nào mình cần thêm vào cho từ bằng cách nhấp vào các nút tương ứng . Mục ñó sẽ xuất hiện 
trong phần soạn thảo và bạn chỉ việc gõ nội dung cần ñưa vào . Sau ñó nhấn nút Save ñể lưu lại và close ñể 
thoát khỏi . Tiếp tục với các từ còn lại và bạn sẽ có một bộ từ ñiển hoàn chỉnh . Bạn có thể tham khảo kỹ hơn 
trong phần trợ giúp của Lạc Việt MTD ( Nhấn Phím F1 hoặc vào menu Help > Help … )  

  

 
  
Chiêu thứ 3 : Thêm từ ñiển ñã có trong máy vào MTD 
  
    Trong chiêu trước , bạn ñã tạo thêm một từ ñiển mới còn chiêu này ,  bạn có thể Import các tập tin .dit vào 
trong Lạc Việt MTD ñể sử dụng ( trong trường hợp : bạn ñược tặng một bộ từ ñiển ñược tạo bằng chiêu số 2 
trên ) . Trước tiên , bạn phải chép tập tin .dit ñó vào thư mục cài ñặt của MTD , sau ñó vào hộp thoại Dictionary 
managerment  , bạn nhấn nút Add ñể MTD tự ñộng dò tìm giúp bạn các bộ từ ñiển ñi lạc ( không có trong danh 
sách từ ñiển trong phần List of Existing dictionaries ) . MTD sẽ dò tìm các tập tin .dit có trong thư mục cài ñặt 
và liệt kê danh sách các từ ñiển mà nó tìm ñược ( trong ñó sẽ có từ ñiển bạn muốn thêm vào ) . Bây giờ , việc 
của bạn là chọn tên từ ñiển trong dictionaries found và nhấn nút Ok ( hình 6 ) . Thế là xong . 
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Chiêu cuối : Chép các mục từ có sẵn vào từ ñiển khác  
Với chiêu này , ta có thể chép các từ trong bộ từ ñiển này vào bộ từ ñiển khác ñể tiết kiệm thời gian và công 
sức bằng cách chọn từ cần chép và vào Menu Tools > Export to …  Hộp thoại Export to Another Dictionary  xuất 
hiện , bạn ñánh dấu kiểm vào từ cần xuất và chọn từ ñiển ñích trong List of existing dictionaries rồi nhấn nút 
Export ñể MTD thực hiện giúp bạn ( hình 7 ) .  
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BEHAVIORS - MỘT CHỨC NĂNG RẤT HAY TRONG FRONTPAGE 2003 
 
 

     ðây là một chức năng rất hay nhưng ít người biết ñến trong Frontpage. Rất tiện lợi , bổ ích cho những người thích thiết kế 
website nhưng không rành về lập trình HTML , java script . Behaviors sẽ giúp bạn tạo ra các website sống ñộng mà không cần 
biết gì về java script !! Khởi ñộng Behaviors : Format > Behaviors… sẽ hiện lên hộp thoại như hình dưới. 

  

 

 
Cách sử dụng : 
  

- Nút Insert : chèn các sự kiện 
- Nút Delete : xoá sự kiện 
Trong bảng Behaviors có 2 phần : 
+ Phần Events : tên sự kiện , bạn có thể thay ñổi các sự 
kiện chính như sau ( khi click vào tên sự kiện sẽ hiện ra 
menu ñể chọn ) : 
- onafterupdate : sau khi cập nhật 
- onclick : khi bạn click chuột vào ñối tượng 
- ondbclick : khi nhấp 2 lần vào ñối tượng 
- onkeydown : khi có một phím ñược nhấn. 
- onkeypress : khi có một phím bị nhấn và giữ không nhả 
lên ( ñè phím ) 
- onkeyup : khi nhả phím 

- onmousedown : khi nhấn chuột vào ñối tượng 
- onmousemover : khi di chuyển chuột trên ñối tượng 
- onmouseout : khi trỏ chuột rời ñối tượng  
- onmouseover : khi di chuyển chuột lên ñối tượng 
- onmouseup : khi click chuột nhưng thả ra liền 
- onresize : khi thay ñổi kích thước 
- onload : khi mở trang web 
- onfilterchange : khi có sự thay ñổi  
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 + Phần Actions : tên hành ñộng ( không thể thay ñổi 
nên khi sai thì Delete rồi Insert lại ) 

- Call Script : gọi một file Java Script. Khi bạn nhấn 
vào ñây có một hộp thoại yêu cầu bạn nhận tên file 
Java Script mà bạn ñã viết ( nên lưu file .js cần dung ở 
thư mục gốc ) 
- Change Property : thay ñổi ñịnh dạng của hình 
ảnh, table , text. Khi nhấp vào sẽ hiện ra một hộp thoại 
với các ñịnh dạng tương ứng, bạn chỉ việc thay ñổi. Có 
một nút chọn phía dưới là Restore on mouseout event : 
tức là sẽ phục hồi ñịnh dạng ban ñầu khi trỏ chuột rời 
ñối tượng. 
- Change Property restore : phục hồi lại ñịnh dạng 
ban ñầu của ñối tượng.( không phải Insert lệnh này khi 
bạn ñã chọn Restore on mouseout event) 
- Check Browser : chọn một trình duyệt ñể mở trang 
web. 
- Check Pulg-in : chọn pulg-in 
- Go to URL : mở một liên kết 
- Jump Menu : tạo một nemu sổ xuống 
- Open Browser Window : mở một trang web với 
cửa sổ mới ( có thể thay ñổi kích thước... của cửa sổ ) 
- Play sound : chơi nhạc 
- Popup message : tạo một thông báo 
- Set text : tạo text trong thanh Status bar hoặc layer 
hoặc frame hoặc text field 
- Swap image : thay ñổi hình ảnh 
- Swap image : phục hồi hình ảnh ban ñầu 

 

  
   
Lưu ý : bạn có thể áp dụng nhiều sự kiện hành ñộng cho một ñối tượng. Chúc các bạn có một website sống ñộng 
bổ ích 
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NHỮNG HƯỚNG DẪN TĂNG CƯỜNG AN TOÀN, BẢO MẬT CHO HỆ THỐNG 
MẠNG 

PHẦN I 
 

 Bùi Hồng Quang  
Sưu tầm tại website Viethacker 

Email: BHQLTT@s.vnn.vn or BHQLTT@vnws.com 

Giới thiệu 

Bài viết này sẽ trình bày các vấn ñề ñược xem là nền tảng của an toàn, bảo mật trong một tổ chức, doanh 
nghiệp. Các vần ñề ñược trình bày bao gồm cả bảo mật ở mức hệ thống và ứng dụng sẽ là cơ sở cho các tổ 
chức khi muốn xây dựng cơ chế bảo mật. Tài liệu cũng giúp bạn rút ngắn ñược thời gian tiếp cận vấn ñề ñảm 
bảo an toàn cho hệ thống mạng nội bộ của mình. Bạn không cần mất nhiều thời gian ñể tìm hiểu mọi thứ. Khi 
xem xét mọi vấn ñề, nơi tốt nhất ñể khởi ñầu chính là các căn bản – ở ñây, chúng tôi sẽ trình bày 6 bước cơ 
bản ñể hệ thống bảo mật tốt hơn.  

Bước 1: Thành lập bộ phận chuyên trách về vấn ñề bảo mật  
Bất kỳ kế hoạch bảo mật nào cũng cần sự hỗ trợ trên nhiều phương diện khác nhau, nếu nó muốn thành công. 
Một trong những phương thức tốt nhất ñể có thể ñược sự hỗ trợ là nên thiết lập một bộ phận chuyên trách về 
vấn ñề bảo mật. Bộ phận này sẽ chịu trách nhiệm trước công ty về  các công việc bảo mật. 

Mục ñích trước tiên của bộ phận này là gây dựng uy tín với khách hàng. Hoạt ñộng của bộ 
phận này sẽ khiến cho khách hàng cảm thấy yên tâm hơn khi làm việc hoặc sử dụng các dịch 
vụ của công ty. Bộ phận này có trách nhiệm thường xuyên cung cấp các lưu ý, cảnh báo liên 
quan ñến an toàn bảo mật thông tin nhằm tránh các rủi ro ñáng tiếc cho khách hàng và công 
ty. 
Bộ phận này còn có trách nhiệm tìm hiểu, ñưa ra giải pháp, cơ chế bảo mật cho toàn công ty. 
Sẽ là hiệu quả và xác thực hơn khi công việc này ñược thực hiện bởi chính ñội ngũ trong 
công ty thay vì ñi thuê một công ty bảo mật khác thực hiện. 

Cuối cùng, một bộ phận chuyên trách về vấn ñề bảo mật có thể thay ñổi cách làm, cách thực hiện công việc 
kinh doanh của công ty ñể tăng tính bảo mật trong khi cũng cải tiến ñược sức sản xuất, chất lượng, hiệu quả và 
tạo ra sức cạnh tranh của công ty. Ví dụ, chúng ta hãy nói ñến VPN (Virtual Private Network), ñây là một công 
nghệ cho phép các nhân viên ñảm bảo an toàn khi ñọc email, làm việc với các tài liệu tại nhà, hay chia sẻ công 
việc giữa hai nhân viên hay hai phòng ban.  

Bước 2: Thu thập thông tin 
Trước khi ñưa ra các thông báo mô tả thực hiện bảo mật, bạn phải lường ñược mọi tình huống sẽ xảy ra, không 
chỉ bao gồm toàn bộ các thiết bị và hệ thống ñi kèm trong việc thực hiện bảo mật mà còn phải kế ñến cả các 
tiền trình xử lý, các cảnh bảo bảo mật, sự thẩm ñịnh hay các thông tin cần ñược bảo vệ. ðiều này rất quan 
trọng khi cung cấp một cái nhìn bao quát về hệ thống bảo mật của công ty. Sự chuẩn bị này cũng nên tham 
chiếu tới các chính sách bảo mật cũng như các hướng dẫn thực hiện của công ty trong vần ñề an toàn bảo mật. 
Phải lường trước ñược những gì xảy ra trong từng bước tiến hành của các dự án. 
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ðể kiểm tra mức ñộ yếu kém của hệ thống, hãy bắt ñầu với những vấn ñề có thể dẫn tới ñộ rủi ro cao nhất 
trong hệ thống mạng của bạn, như Internet. Hãy sử dụng cơ chế bảo mật bên ngoài từ sản phẩm của một hãng 
có danh tiếng, có thể cung cấp thông tin cần thiết ñể ước lượng mức bảo mật hiện tại của công ty bạn khi bị tấn 
công từ Internet. Sự thẩm ñịnh này không chỉ bao gồm việc kiểm tra các lỗ hổng, mà còn gồm cả các phân tích 
từ người sử dụng, hệ thống ñược kết nối bằng VPN, mạng và các phân tích về thông tin công cộng sẵn có.  

Một trong những cân nhắc mang tính quan trọng là thẩm ñịnh từ bên ngoài vào. ðây chính là ñiểm mấu chốt 
trong việc ñánh giá hệ thống mạng. ðiển hình, một công ty sử dụng cơ chế bảo mật bên ngoài, cung cấp các 
dịch vụ email, Web theo cơ chế ñó, thì họ nhận ra rằng, không phải toàn bộ các tấn công ñều ñến từ Internet. 
Việc cung cấp lớp bảo mật theo account, mạng bảo vệ bản thân họ từ chính những người sử dụng VPN và các 
ñồng nghiệp, và tạo ra các mạng riêng rẽ từ các cổng truy cập ñầu cuối là toàn bộ các ưu thế của cơ chế này. 

Cơ chế bảo mật bên trong cũng giúp việc quản lý bảo mật công ty ñược tốt hơn. Bằng cách kiểm tra toàn bộ 
công việc kinh doanh, các cơ chế chính sách, các quá trình xử lý, xác thực dữ liệu tương phản với những 
gì ñược mô tả, hay sự tương thích với những chuẩn ñã tồn tại ñược thẩm ñịnh. Cơ chế bảo mật bên trong cung 
cấp thông tin một cách chi tiết tương tự như việc khảo sát kỹ lưỡng phạm vi ở mức sâu hơn, thậm chí bao gồm 
cả việc phá mã mật khẩu và các công cụ phân tích hệ thống ñể kiểm tra tính tương thích về chính sách trong 
tương lai.  

Bước 3: Thẩm ñịnh tính rủi ro của hệ thống  
Khi thẩm ñịnh tính rủi ro của hệ thống, hãy sử dụng công thức sau: 

Tính rủi ro = Giá trị thông tin * Mức ñộ của lỗ hổng * Khả năng mất thông tin 

Tính rủi ro bằng với giá trị thông tin trong câu hỏi (bao gồm giá trị ñồng tiền, giá trị thời gian 
máy bị lỗi do lỗi bảo mật, giá trị mất mát khách hàng – tương ñối), thời gian của quy mô lỗ 
hổng (tổng cộng/từng phần của tổn thất dữ liệu, thời gian hệ thống ngừng hoạt ñộng, sự 
nguy hiểm khi dữ liệu hỏng), thời gian về khả năng xuất hiện mất thông tin. 
ðể lấy ñược các kết quả từ bước ñầu (các giá trị, báo cáo về cơ chế bảo mật ngoài, và chính 
sách bảo mật), và tập trung vào 3 trong số các mặt thường ñược ñề cập. Sau ñó, bắt ñầu với 
một số câu hỏi khung sau: 

• Cơ chế bảo mật ñã tồn tại của công ty có ñược ñề ra rõ ràng và cung cấp ñủ biện 
pháp bảo mật chưa? 

• Kết quả từ cơ chế bảo mật bên ngoài có hợp lệ so với chính sách bảo mật của công 
ty? 

• Có mục nào cần sửa lại trong cơ chế bảo mật mà không ñược chỉ rõ trong chính sách? 
• Hệ thống bảo mật sẽ mất tác dụng trong tính rủi ro cao nhất nào? 
• Giá trị, thông tin gì mang tính rủi ro cao nhất? 

Các câu trả lời cung cấp cái nhìn toàn diện cho việc phân tích về toàn bộ chính sách bảo mật 
của công ty. Có lẽ, thông tin quan trọng ñược lấy trong quá trình kết hợp các giá trị thẩm 
ñịnh và tính rủi ro tương ứng. Theo giá trị thông tin, bạn có thể tìm thấy các giải pháp mô tả 
ñược toàn bộ các yêu cầu, bạn có thể tạo ra một danh sách quan tâm về lỗ hổng bảo mật. 

Bước 4: Xây dựng giải pháp  

Trên thực tế không tồn tại giải pháp an toàn, bảo mật thông tin dang Plug and Play cho các tổ chức ñặc biệt khi 
phải ñảm bảo các luật thương mại ñã tồn tại và phải tương thích với các ứng dụng, dữ liệu sắn có. Không có 



Sưu Tầm Thủ Thuật                                               traitimbinhyen_nova@yahoo.com 

http://vietdown.org                                                                                                   Nguyễn Anh Tú         

một tài liệu nào có thể lượng hết ñược mọi lỗ hổng trong hệ thống và cũng không có nhà sản xuất nào có thể 
cung cấp ñủ các công cụ cần thiết. Cách tốt nhẫt vẫn là sử dụng kết hợp các giải pháp, sản phẩm nhằm tạo ra 
cơ chế bảo mật ña năng.  

Firewall 
Xem xét và lựa chọn một sản phẩm firewall hợp lý và ñưa và hoạt ñộng phù hợp với chính 
sách của công ty là một trong những việc ñầu tiên trong quá trình bảo mật hệ thống. Firewall 
có thể là giải pháp phần cứng hoặc phần mềm hoặc kết hợp cả hai. Nhiệm vụ của firewall là 
ngăn chặn các tấn công trực tiếp vào các thông tin quan trọng của hệ thống, kiểm soát các 
thông tin ra vào hệ thống. Việc lựa chọn firewall thích hợp cho một hệ thống không phải là 
dễ dàng. Các firewall ñều phụ thuộc trên một môi trường, cấu hình mạng, ứng dụng cụ thể. 
Khi xem xét lựa chọn một firewall, cần tập trung tìm hiểu tập các chức năng của firewall, tính 
năng lọc ñịa chỉ, gói tin, ... 
  

Hệ thống kiểm tra xâm nhập mạng (IDS) 

Một firewall ñược gọi là tốt chỉ khi nó có thể lọc và tạo khả năng kiểm soát các gói tin khi ñi qua nó. Và ñây 
cũng chính là nơi mà hệ thống IDS nhập cuộc. Nếu bạn xem firewall như một con ñập ngăn nước, thì thì bạn có 
thể ví IDS như một hệ thống ñiều khiển luồng nước trên các hệ thống xả nước khác nhau. Một IDS, không liên 
quan tới các công việc ñiều khiển hướng ñi của các gói tin, mà nó chỉ có nhiệm vụ phân tích các gói tin mà 
firewall cho phép ñi qua, tìm kiếm các chữ kí tấn công ñã biết (các chữ kí tấn công chính là các ñoạn mã ñược 
biết mang tính nguy hiểm cho hệ thống) mà không thể kiểm tra hay ngăn chặn bởi firewall. IDS tương ứng với 
việc bảo vệ ñằng sau của firewall, cung cấp việc chứng thực thông tin cần thiết ñể ñảm bảo chắc chắn cho 
firewall hoạt ñộng hiệu quả. 

Hệ thống kiểm tra xâm phạm dựa theo vùng (H-IDS) 
Sự lựa chọn, thực hiện và sử dụng một hệ thống kiểm tra sự xâm phạm trên máy chủ dựa trên nhiều hệ ñiều 
hành và môi trường ứng dụng chỉ ñịnh. Một hàm chức năng ñầy ñủ của H-IDS có thể cung cấp các thông báo 
ñều ñặn theo thời gian của bất kỳ sự thay ñổi nào tới máy chủ từ tác ñộng bên trong hay bên ngoài. Nó là một 
trong những cách tốt nhất ñể giảm thiểu sự tổn thương của hệ thống. Việc tìm kiếm hệ thống mà hỗ trợ hầu 
hết các hệ ñiều hành sử dụng trong tổ chức của bạn nên ñược xem như một trong những quyết ñịnh chính cho 
mỗi H-IDS. 

Hệ thống kiểm tra xâm phạm dựa theo ứng dụng (App-IDS) 

Số lượng App-IDS xuất hiện trên thị trường ngày càng nhiều. Các công cụ này thực hiện việc phân tích các 
thông ñiệp từ một ứng dụng cụ thể hay thông tin qua proxy tới ứng dụng ñó. Trong lúc chúng có mục ñích cụ 
thể, chúng có thể cung cấp mức bảo mật tăng lên theo từng mảng ứng dụng cụ thể. Khi ñược kết hợp với một 
H-IDS, chúng ñảm bảo rằng sự xâm nhập tới một máy chủ sẽ giảm thiểu. Một App-IDS nên ñược xem như một 
chức năng hỗ trợ bảo mật trong suốt, mặc dù không ñúng trong một số trường hợp. 

Phần mềm Anti-Virus (AV) 
Phần mềm AV nên ñược cài trên toàn bộ máy trạm (workstation), máy chủ (server), hệ thống 
hỗ trợ dịch vụ số, và hầu hết những nơi chứa dữ liệu quan trọng vào ra. Hai vấn ñề quan 
trọng nhất ñể xem xét khi ñặt yêu cầu một nhà sản xuất AV quản lý nhiều máy chủ và máy 
trạm trên toàn bộ phạm vi của công ty là khả năng nhà cung cấp ñó có ñối phó ñược các ñe 
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doạ từ virus mới hay không. (nguyên nhân: không bao giờ cho rằng phầm mềm ñang chạy, 
luôn kiểm tả phiên bản của virus và các file cập nhật cho virus mới). 
Mạng riêng ảo (VPN) 

Việc sử dụng VPN ñể cung cấp cho các nhân viên hay các cộng sự truy cập tới các tài nguyên của công ty từ 
nhà hay nơi làm việc khác với mức bảo mật cao, hiệu quả nhất trong quá trình truyền thông, và làm tăng hiệu 
quả sản xuất của nhân viên. Tuy nhiên, không có ñiều gì không ñi kèm sự rủi ro. Bất kỳ tại thời ñiểm nào khi  
một VPN ñược thiết lập, bạn phải mở rộng phạm vi kiểm soát bảo mật của công ty tới toàn bộ các nút ñược kết 
nối với VPN.  

ðể ñảm bảo mức bảo mật cho hệ thống này, người sử dụng phải thực hiện ñầy ñủ các chính sách bảo mật của 
công ty. ðiều này có thể thực hiện ñược qua việc sử dụng các hướng dẫn của nhà sản xuất về dịch vụ VPN như 
hạn chế các ứng dụng có thể chạy ở nhà, cổng mạng có thể mở, loại bỏ khả năng chia kênh dữ liệu, thiết lập hệ 
thống bảo vệ virus khi chạy hệ thống từ xa, tất cả công việc này giúp giảm thiểu tính rủi ro. ðiều này rất quan 
trọng ñối với các công ty phải ñối mặt với những ñe doạ trong việc kiện cáo, mạng của họ hay hệ thống ñược 
sử dụng ñể tấn công các công ty khác. 

Sinh trắc học trong bảo mật 
Sinh trắc học ñã ñược biết ñến từ một số năm trước ñây, nhưng cho ñến nay vẫn có rất 
nhiều khó khăn cho việc nhân rộng ñể áp dụng cho các hệ thống bảo mật thương mại. Dấu 
tay, tròng mắt, giọng nói, ..., cung cấp bảo mật mức cao trên các mật khẩu thông thường 
hay chứng thực hai nhân tố, nhưng cho ñến hiện tại, chúng cũng vẫn ñược coi như phương 
thức tốt nhất ñể truy cập vào hệ thống.   

Các thế hệ thẻ thông minh 

Các công ty gần ñây sử dụng ñã sử dụng thẻ thông minh như một phương thức bảo mật hữu hiệu. Windows 
2000 cung cấp cơ chế hỗ trợ thẻ thông minh như một phương tiện chính trong việc chứng thực quyền ñăng 
nhập hệ thống. Nói chung, sự kết hợp ña công nghệ (như tròng mắt, thẻ thông minh, dấu tay) ñang dần hoàn 
thiện và mở ra một thời ñại mới cho việc chứng thực quyền truy cập trong hệ thống bảo mật. 

Kiểm tra máy chủ 
Sự kiểm tra ñều ñặn mức bảo mật ñược cung cấp bởi các máy chủ phụ thuộc chủ yếu vào sự 
quản lý. Mọi máy chủ ở trong một công ty nên ñược kiểm tra  từ Internet ñể phát hiện lỗ 
hổng bảo mật. Thêm nữa, việc kiểm tra từ bên trong và quá trình thẩm ñịnh máy chủ về căn 
bản là cần thiết ñể giảm thiểu tính rủi ro của hệ thống, như khi firewall bị lỗi hay một máy 
chủ, hệ thống nào ñó bị trục trặc. 
Hầu hết các hệ ñiều hành ñều chạy trong tình trạng thấp hơn với mức bảo mật tối thiểu và 
có rất nhiều lỗ hổng bảo mật. Trước khi một máy chủ khi ñưa vào sản xuất, sẽ có một quá 
trình kiểm tra theo một số bước nhất ñịnh. Toàn bộ các bản sửa lỗi phải ñược cài ñặt trên 
máy chủ, và bất cứ dịch vụ không cần thiết nào phải ñược loại bỏ. ðiều này làm tránh ñộ rủi 
ro xuống mức thấp nhất cho hệ thống. 
Việc tiếp theo là kiểm tra các log file từ các máy chủ và các ứng dụng. Chúng sẽ cung cấp 
cho ta một số thông tin tốt nhất về hệ thống, các tấn công bảo mật. Trong rất nhiều trường 
hợp, ñó chính là một trong những cách ñể xác nhận quy mô của một tấn công vào máy chủ. 
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Kiểm soát ứng dụng 
Vấn ñề an toàn bảo mật trong mã nguồn của các ứng dụng hầu hết không ñược quan tâm. ðiều này không 

ñược thể hiện trên các sản phẩm như liệu nó có ñược mua, ñược download miễn phí hay ñược phát triển từ một 

mã nguồn nào ñó. ðể giúp ñỡ giảm thiểu sự rủi ro bảo mật trong các ứng dụng, thẩm ñịnh lại giá trị của ứng 

dụng trong công ty, như công việc phát triển bên trong của các ứng dụng, ðiều này cũng có thể bao gồm các 

ñánh giá của các thực thể bên ngoài như ñồng nghiệp hay các khách hàng. 

Việc ñiều khiển cấu hình bảo mật các ứng dụng có thể làm tăng mức bảo mật. Hầu hết các 
ứng dụng ñược cấu hình tại mức tối thiểu của tính năng bảo mật, nhưng qua các công cụ cấu 
hình, mức bảo mật của hệ thống có thể ñược tăng lên. Lượng thông tin kiểm soát ñược cung 
cấp bởi ứng dụng cũng có thể ñược cấu hình. Nơi mà các ứng dụng cung cấp thông tin về 
quy mô bảo mật, thời gian kiểm soát và sự phân tích thông tin này sẽ là chìa khoá ñể kiểm 
tra các vấn ñề bảo mật thông tin. 

Các hệ ñiều hành 

Sự lựa chọn hệ ñiều hành và ứng dụng là quá trình ñòi hỏi phải có sự cân nhắc kỹ càng. Chọn cái gì giữa hệ 
ñiều hành Microsoft hay UNIX, trong rất nhiều trường hợp, ñiều thường do ấn tượng cá nhân ề sản phẩm. Khi 
lựa chọn một hệ ñiều hành, thông tin về nhà sản xuất không quan trọng bằng những gì nhà sản xuất ñó làm 
ñược trong thực tế, về khả năng bảo trì hay dễ dàng thực hiện với các tài liệu ñi kèm. Bất kỳ một hệ ñiều hành 
nào từ 2 năm trước ñây ñều không thể ñảm bảo theo những chuẩn ngày nay, và việc giữ các máy chủ, ứng 
dụng của bạn ñược cập nhật thường xuyên sẽ ñảm bảo giảm thiểu khả năng rủi ro của hệ thống.  

Khi lựa chọn một hệ ñiều hành, hãy tìm hiểu không chỉ các tiêu chuẩn thông thường như (quản trị, hiệu năng, 
tính chứng thực), mà còn phải xem xét khả năng áp dụng ñược của hệ ñiều hành với hệ thống hiện tại. Một hệ 
ñiều hành có thể cung cấp cơ chế bảo mật tốt hơn khi nó tương thích với các ứng dụng chạy bên trong nó như 
DNS hay WebServer, trong khi các hệ ñiều hành khác có thể có nhiều chức năng tốt hơn như một hệ thống 
application, database hay email server. 

Bước 5: Thực hiện và giáo dục 
Ban ñầu, sự hỗ trợ cần thiết sẽ ñược ñúc rút lại và lên kế hoạch hoàn chỉnh cho dự án bảo mật. ðây chính là 
bước ñi quan trọng mang tính chiến lược của mỗi công ty về vấn ñề bảo mật. Các chi tiết kỹ thuật của bất kỳ sự 
mô tả nào cũng sẽ thay ñổi theo môi trường, công nghệ, và các kỹ năng liên quan, ngoài ra có một phần không 
nằm trong việc thực thi bảo mật nhưng chúng ta không ñược coi nhẹ, ñó chính là sự giáo dục. ðể ñảm bảo sự 
thành công bảo mật ngay từ lúc ñầu, người sử dụng phải có ñược sự giáo dục cần thiết về chính sách, gồm có: 

•  Kỹ năng về các hệ thống bảo mật mới, các thủ tục mới. 
• Hiểu biết về các chính sách mới về tài sản, dữ liệu quan trọng của công ty. 
• Hiểu các thủ tục bắt buộc mới, chính sách bảo mật công ty. 

Nói tóm lại, không chỉ ñòi hỏi người sử dụng có các kỹ năng cơ bản, mà ñòi hỏi học phải biết như tại sao và cái 
gì họ ñang làm là cần thiết với chính sách của công ty. 
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Bước 6: Tiếp tục kiểm tra, phân tích và thực hiện 
Hầu hết những gì mong ñợi của một hệ thống bảo mật bất kỳ là chạy ổn ñịnh, ñiều khiển 
ñược hệ thống và nắm bắt ñược các luồng dữ liệu của hệ thống. Quá trình phân tích, tổng 
hợp các thông tin, sự kiện từ firewall, IDS’s, VPN, router, server, và các ứng dụng là cách duy 
nhất ñể kiểm tra hiệu quả của một hệ thống bảo mật, và cũng là cách duy nhất ñể kiểm tra 
hầu hết sự vi phạm về chính sách cũng như các lỗi thông thường mắc phải với hệ thống. 

Các gợi ý bảo mật cho hệ thống và mạng 

Theo luận ñiểm này, chúng tôi tập trung chủ yếu và các bước mang tính hệ thống ñể cung cấp một hệ thống 
bảo mật. Từ ñây, chúng tôi sẽ chỉ ra một vài bước ñi cụ thể ñể cải thiện hệ thống bảo mật, dựa trên kết quả 
của việc sử dụng các phương thức bảo mật bên ngoài và bảo mật bên trong của hệ thống. Chúng tôi cũng giới 
hạn phạm vi của các gợi ý này theo các vấn ñề chung nhất mà chúng tôi ñã gặp phải, ñể cung cấp, mô tả vấn 
ñề một cách chính xác hơn cũng như các thách thức mà mạng công ty  phải ñối mặt ngày nay. ðể mang tính 
chuyên nghiệp hơn về IT, các gợi ý này ñược chia thành các phần như sau: 

ðặc ñiểm của bảo mật 
• Tạo bộ phận chuyên trách bảo mật ñể xem xét toàn bộ các vấn ñề liên quan tới bảo mật 
• Thực hiện các thông báo bảo mật tới người sử dụng ñể ñảm bảo mọi người hiểu và thực hiện theo các 

yêu cầu cũng như sự cần thiết của việc thực hiện các yêu cầu ñó. 
• Tạo, cập nhật, và theo dõi toàn bộ chính sách bảo mật của công ty. 

Windows NT/IIS 
•  Hầu hết 95% các vấn ñề bảo mật của NT/IIS, chúng ta có thể giải quyết theo các bản sửa lỗi. ðảm bảo 

chắc chắn toàn bộ các máy chủ NT và IIS ñược sửa lỗi với phiên bản mới nhất. 
•  Xoá (ñừng cài ñặt) toàn bộ các script từ Internet. 

Cisco Routers 
•  Loại bỏ các tính năng như finger, telnet, và các dịch vụ, cổng khác trên thiết bị ñịnh tuyến (router). 
•  Bỏ các gói tin tài nguyên IP dẫn ñường trong router. 
• Chạy Unicast RPF ñể ngăn chặn người sử dụng của bạn sử dụng việc giả mạo IP. 
• Sử dụng router của bạn như một firewall phía trước và thực hiện các ACL tương tự theo các luật trong 

firewall của bạn. 

Quy ñịnh chung về cầu hình firewall 

• Cấu hình của firewall nên có các luật nghiêm ngặt. Chỉ rõ các luật ñối với từng loại truy nhập cả bên 
ngoài lẫn bên trong. 

• Giảm thiểu các truy nhập từ xa tới firewall. 
• Cung cấp hệ thống kiểm soát tập luật của firewall. 
• Kiểm tra lại các luật. 

Cisco PIX Firewalls 

•  Không cho phép truy cập qua telnet 
• Sử dụng AAA cho việc truy cập, ñiều khiển hệ thống console 
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Kiểm soát Firewall-1 
• Loại bỏ các luật mặc ñịnh cho phép mã hoá và quản lý của firewall, thay thế các luật không rõ ràng 

bằng các luật phân biệt rạch ròi trong công việc thực thi của bạn. 
• Không sử dụng mặc ñịnh luật “allow DNS traffic” - chấp nhận luật này chỉ cho các máy chủ cung cấp 

DNS cho bên ngoài. 

DNS bên trong 
• Bất kỳ máy chủ nào cung cấp DNS bên trong và các dịch vụ mang tính chất nội bộ phải không ñược 

cung cấp DNS bên ngoài. 
• Kiểm tra với nhà cung cấp DNS của bạn ñể cấu hình bảo vệ từ thuộc tính “cache poisoning” 

(Dịch theo tài liệu Comprehensive guide to securing networks and system) 
  

NHỮNG HƯỚNG DẪN TĂNG CƯỜNG AN TOÀN, BẢO MẬT CHO HỆ THỐNG 
MẠNG 

Mười quy tắc then chốt về an toàn và bảo mật  
PHẦN II 

Tại trung tâm hỏi ñáp về an toàn bảo mật thông tin của hãng Microsoft, hàng nghìn các bản báo cáo về an ninh 
hệ thống ñã ñược nghiên cứu trong mỗi năm. Trong một số trường hợp, kết quả về mức ñộ an toàn của hệ 
thống xuất phát từ lỗi trong sản phẩm. ðiều này có nghĩa là sẽ có một bản sửa lỗi phát triển ngay sau ñó 
ñể khắc phục lỗi vừa tìm ñược. Trong một số trường hợp, các vấn ñề ñược báo cáo là kết quả ñơn giản do lỗi 
của ai ñó tạo ra trong quá trình sử dụng sản phẩm. Nhưng lại có rất nhiều trường hợp mà không rơi vào hai 
trường hợp trên. ðó chính là các vấn ñề an toàn bảo mật thông tin thực sự, nhưng các vấn ñề này lại không do 
các thiếu sót từ sản phẩm. Theo năm tháng, một danh sách về những vấn ñề như vậy ñã ñược phát triển gọi là 
“Mười quy tắc then chốt về an toàn và bảo mật”.  

ðừng giữ hệ thống của bạn hoạt ñộng trong khi chờ ñợi một phiên bản sửa lỗi mới, mà hãy bảo vệ bạn từ các 
vấn ñề mà chúng tôi ñưa ra dưới ñây. Các lỗi này không thể do Microsoft – hay bất kì các nhà sản xuất phần 
mềm nào có thể sửa ñược, bởi vì chúng ñược tạo ra do chính cách hoạt ñộng của các máy tính. Nhưng cũng 
ñừng ñánh mất hết hi vọng - ñiều này phụ thuộc vào chính bản thân bạn với các lỗi này, và nếu bạn giữ chúng 
trong ñầu mình, bạn có thể cải thiện một cách ñáng kể các hệ thống bảo mật của bạn.  

Luật #1 : Nếu một người nào ñó có thể thuyết phục bạn chạy chương trình của anh ta trên máy 
tính của bạn, Nó sẽ không còn là máy tính của bạn nữa.  

Nó chính là một trường hợp ñáng tiếc của hệ thống máy tính : khi một chương trình máy tính chạy, nó sẽ thực 
hiện phần việc ñã ñược lập trình, thậm chí nếu phần việc ñã ñược lập trình gây nguy hiểm cho hệ thống máy 
tính. Khi bạn lựa chọn một chương trình, chính bạn ñang quyết ñịnh bật chế ñộ ñiều khiển máy tính cho chương 
trình ñó. Khi một chương trình chạy, nó có thể làm bất kì thứ gì, trên cả những công việc mà bạn có thể làm ñối 
với hệ thống. Nó có thể ñiều khiển các phím bấm của bạn, nhận lấy thông tin và gửi chúng tới một website. Nó 
có thể mở mọi tài liệu trên hệ thống, và thay ñổi chúng với từ “sẽ” trở thành “sẽ không” trong toàn bộ chúng. 
Nó cũng có thể gửi email khiếm nhã tới các người bạn của bạn hay có thể cài ñặt một chương trình virus, tạo ra 
một “cửa phụ” mà dựa vào nó, một người khác có thể ñiều khiển máy tính của bạn từ xa. 

ðó chính là lí do tại sao thật là quan trọng khi chạy, thậm chí download một chương trình từ một tài nguyên 
không chứng thực. “Tài nguyên”, ở ñây tôi muốn nói tới người viết nó, không phải người ñưa nó cho bạn. Có 
một sự phân tích thú vị giữa việc chạy một chương trình và việc ăn một chiếc bánh sandwich. Nếu một người xa 



Sưu Tầm Thủ Thuật                                               traitimbinhyen_nova@yahoo.com 

http://vietdown.org                                                                                                   Nguyễn Anh Tú         

lạ ñi tới bạn và ñưa cho bạn một chiếc bánh sandwich, vậy liệu bạn có ăn nó không? có lẽ là không. Nếu người 
bạn thân nhất của bạn ñưa bạn chiếc bánh ñó thì sao?, có lẽ bạn sẽ ăn, có lẽ bạn sẽ không, - ñiều này phụ 
thuộc vào liệu cô ấy làm nó hay tìm thấy nó trên phố. Việc lựa chọn sử dụng một chương trình cũng giống như 
bạn với chiếc bánh sandwich, ñiều này sẽ giúp bạn an toàn với hệ thống máy tính của bạn.  

Luật #2: Nếu một người nào ñó có thể sửa ñổi hệ ñiều hành trên máy tính của bạn, Nó sẽ không 
còn là máy tính của bạn nữa.  

Nhìn chung, hệ ñiều hành chỉ là một tập của các con số 1 và con số 0, khi ñược dịch bởi bộ vi xử lí. Việc thay 
ñổi các con số 1 và số 0, nó sẽ làm cho một vài thứ khác ñi. Nơi nào các con số 1 và số 0 này ñược lưu? Tại 
sao, trên hệ thống máy, thứ tự các con số luôn ñi cùng với mọi thứ khác. Chúng chỉ là các file, và nếu một 
người nào khác có thể sử dụng hệ thống và ñược quyền thay ñổi các file ñó, ñiều này có nghĩa là hệ thống của 
bạn ñã chết. 

ðể hiểu ñược tại sao, hãy xem hệ ñiều hành như các file giữa các thành phần ñược chứng thực trên máy tính, 
và chúng chạy, nhìn chung, với mức ñộ ưu tiên cao. ðiều này có nghĩa là chúng có thể làm hầu hết mọi thứ. 
Giữa các thứ khác, chúng ñược chứng thực ñể quản lý account của user, ñiều khiển việc thay ñổi password, và 
tạo ra các luật  ñiều khiển những ai thao tác trên máy tính. Nếu một người nào ñó có thể thay ñổi chúng, hệ 
thống sẽ không còn hoạt ñộng ñúng nữa và tuân theo thao tác của anh ta, và sẽ không có ñiều gì có thể cản 
nổi những gì anh ta can thiệp tới hệ thống. Anh ta có thể ăn cắp password, tạo cho anh ta có quyền quản trị hệ 
thống, hay thêm toàn bộ các chức năng mới tới hệ ñiều hành. ðể ngăn cản kiểu tấn công này, phải ñảm bảo 
chắc chắn rằng các file hệ thống ñược bảo vệ tốt nhất.  

Luật #3: Nếu một người nào ñó truy cập vật lí không hạn chế tới máy tính của bạn. Nó sẽ không 
còn là máy tính của bạn nữa.  

Mọi thứ mà một người nào ñó có thể làm ñược nếu anh ta có thể ñặt cánh tay của anh ta tới máy tính của bạn.  

• Anh ta có thể quản lí ñược hệ thống bảo vệ an toàn, và làm hỏng máy tính của bạn với công việc phá 
hoại của anh ta.  

• Anh ta có thể gỡ bỏ máy tính, loại nó ra khỏi tầm kiểm soát của bạn, và giữ nó với các ñòi hỏi của mình  
• Anh ta có thể khởi ñộng máy tính từ một ñĩa mềm, và ñịnh dạng (format) lại ñĩa cứng của bạn. Nhưng 

hãy ñợi, bạn ñịnh nói, tôi ñã cấu hình BIOS trên máy tính của tôi với mật khẩu bảo vệ khi tôi khởi ñộng 
máy tính. ðiều này không có nghĩa gì, nếu anh ta có thể mở ñược trong trường hợp này và với ñược tới 
máy tính của bạn, anh ta có thể chỉ cần thay ñổi các con chip của BIOS. (Thực tế còn có nhiều các cách 
dễ dàng hơn rất nhiều).  

• Anh ta có thể loại bỏ ổ cứng từ máy tính của bạn, cắm nó vào máy tính của anh ta và ñọc nó.  
• Anh ta có thể tạo ra một bản sao ổ cứng của bạn, khi ñó, anh ta sẽ có ñủ thời gian ñể thực hiện mọi ý 

ñịnh của mình trước khi phá hoại hệ thống của bạn, như cố gắng tìm kiểm mật khẩu, mà các chương 
trình hiện tại ñược làm theo thuật toán có sắn sẽ tự ñộng làm ñiều ñó. Việc có ñủ thời gian sẽ giúp anh 
ta thành công.  

• Anh ta có thể gài thêm một con chip nhỏ vào bàn phím của bạn, lúc này anh ta có thể ñiều khiển ñược 
mọi thứ mà bạn ñánh vào, bao gồm cả mật khẩu của bạn.  

Luôn luôn ñảm bảo chắc chắn rằng một máy tính ñược bảo vệ về mặt vật chất, và nhớ rằng giá trị của hệ thống 
bao gồm không chỉ giá trị của bản thân phần cứng, mà còn giá trị của dữ liệu trên nó, và giá trị truy cập tới 
mạng của bạn mà người lạ ñó có thể truy cập vào. Mức tối thiểu, các hệ thống thương mại quan trọng như các 
ñiều khiển vùng (domain controller), các máy chủ cơ sở dữ liệu (database server) và các máy chủ dịch vụ in hay 
máy chủ chia se file nên ñược khoá mà chỉ cho phép người có quyền quản trị bảo trì và truy cập. Nhưng bạn có 
thể xem xét việc bảo vệ các hệ thống tốt hơn với các phương thức bảo vệ ñược thêm vào cho mỗi hệ thống. 
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Nếu bạn di chuyển với một máy tính cầm tay, có lẽ rằng bạn nên bảo vệ nó. Các chức năng tương tự mà tạo 
cho máy tính cầm tay nhỏ về kích cỡ, nhẹ về khối lượng,.. cũng tạo cho chúng dễ bị ñánh cắp hơn. Có rất nhiều 
cách bảo vệ như các loại khoá hay các chuông báo ñộng cho các loại máy cầm tay, và một vài mô hình giúp bạn 
tháo rời ổ cứng ra khỏi máy tính và có thể mang trong người bạn. bạn cũng có thể sử dụng các chức năng như 
mã hoá các file hệ thống ñể làm giảm nguy cơ nếu một ngời nào ñó ăn cắp ñược máy tính. Nhưng chỉ có cách 
chắc chắn rằng dữ liệu của bạn an toàn và ổ cứng của bạn không bị phá là bạn nên giữ máy tính cầm tay lúc 
nào cũng ñi theo bạn trong toàn bộ chuyến hành trình.  

Luật #4: Nếu bạn cho phép một người nào ñó ñẩy các chương trình tới website của bạn. Nó sẽ 
không còn là website của bạn.  

ðiều này dựa trên luật 1, trong luật này người nào ñó dùng thủ ñoạn tiếp cận với nạn nhân trong khi download 
chương trình có hại trên hệ thống của anh ta và chạy nó. Còn trong trường hợp này, anh ta sẽ ñẩy chương trình 
có hại tới hệ thống và chạy nó. Có rất nhiều người khi quản lý website quá ưu ñãi với khách hàng của họ, và 
cho phép các vị khách có thể ñẩy các chương trình tới site và chạy chúng. ðiều này có thể dẫn tới hệ thống bị 
xâm phạm.  

Nếu bạn quản lý một website, bạn cần phải giới hạn các vị khách có thể làm gì. Bạn chỉ nên cho phép một 
chương trình trên site của bạn chạy nếu bản thân bạn viết ra, hay nếu bạn tin tưởng ñược nhà phát triển mà 
viết chương trình ñó. Nhưng ñiều ñó vẫn còn có thể là không ñủ. Nếu wesite của bạn là một trong một vài máy 
ñược ñánh ñịa chỉ trên một máy chủ chia sẻ tài nguyên, bạn cần phải hết sức cẩn thận. Nếu một người nào ñó 
có thể thoả thuận với một trong những site trên server, nó có thể giúp anh ta mở rộng ñiều khiển của mình tới 
máy chủ, mà anh ấy có thể ñiều khiển ñược mọi site trên ñó, bao gồm cả bạn. Nếu bạn ñang trên một máy chủ 
ñược dùng chung, ñiều quan trọng là phải tìm ra chính sách quản trị của server ñó là gì.  

Luật #5: Các mật khẩu dễ nhận có thể làm hỏng hệ thống bảo mật mạnh  

Mục ñích của việc ñăng nhập vào máy là ñể biết bạn là ai. Ban ñầu, hệ ñiều hành biết bạn là ai, nó có thể cho 
phép ban truy cập tài nguyên hay từ chối. Nếu một người nào ñó học ñược mật khẩu của bạ, anh ta có thể 
ñăng nhập như bạn. Trong thực tế, nếu anh ta thành công, hệ thống máy sẽ coi anh ta là bạn. Bất kì bạn có thể 
thao tác gì với hệ thống, anh ta cũng có thể làm như vậy. Có lẽ bạn có các quyền trên mạng hơn anh ra và bạn 
có thể làm những thao tác mà anh ta bình thường anh ta không thể thực hiện. Hay có thể anh ta chỉ muốn làm 
một ñiều gì ñó có ác ý hay ñe doạ bạn. Trong bất kì trường hợp nào, tốt nhất nên bảo vệ mật khẩu của bạn.  

Luôn luôn sử dụng một mật khẩu, và lựa chọn một mật khẩu phức tạp. ðừng sử dụng tên con vật của bạn, tên 
ngày cưới, hay tên của ñội bóng ñịa phương mà bạn yêu thích. Và cũng ñừng sử dụng từ “password” làm mật 
khẩu. Lấy mật khẩu nên tạo ra bằng cách có các kí tự viết chữ hoa và chữ thường ñứng không theo thứ tự nào, 
nên sử dụng cả các con số, dấu chấm,... và tạo ra mật khẩu có ñộ dài vừa ñủ, và phải nhớ thay ñổi mật khẩu 
thường xuyên. Không ñược viết mật khẩu ra giấy, hay bất kì ñâu cho dễ nhớ. Không ñược nói cho bất kì ai về 
mật khẩu của bạn là gì.  

Cuối cùng, xem xét sử dụng một cái gì ñó dài hơn mật khẩu của bạn ñể ñịnh danh bản thân bạn với hệ thống. 
Bạn cũng có thể muốn các sản phẩm hiện ñại như nhận dạng dấu vân tay, và quét tròng mắt ñể thay thế mật 
khẩu truyền thống.  

Luật #6: Một hệ thống chỉ có ñộ an toàn như sự tin tưởng nhà quản trị  

Mọi máy tính phải có một nhà quản trị : là một người nào ñó có thể cài ñặt chương trình phần mềm, cấu hình 
hệ ñiều hành, thêm và quản lí các account của user, thiết lập các chính sách về bảo mật, và ñiều khiển các thao 
tác quản lí ñược liên kết với việc giữ cho máy tính chạy tốt. Theo ñịnh nghĩa, các thao tác này ñòi hỏi anh ta có 
toàn quyền với hệ thống. ðiều này ñặt nhà quản trị trong một vị trí rất quan trọng với hệ thống. Với một nhà 
quản trị không ñáng tin cậy có thể loại bỏ hoàn toàn các quy chế về an toàn bảo mật mà bạn ñã tạo ra. Anh ra 
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có thể thay ñổi quyền trên hệ thống, sửa các chính sách bảo mật của hệ thống, cài ñặt các chương trình có hại 
vào trong hệ thống, thêm các user không có thật vào trong hệ thống hay làm bất kì ñiều gì với hệ thống. Anh ta 
có thể làm hỏng hệ thống ảo và bảo vệ của hệ ñiều hành, bởi vì anh ta ñiều khiển nó. Nếu bạn có một nhà 
quản trị không mấy tin tưởng, bạn có thể không có chế ñộ bảo mật.  

Khi thuê một nhà quản trị hệ thống, hãy nhìn nhận vị trí tin cậy của nhà quản trị, và chỉ muợn những người mà 
có chứng nhận về ñộ tin cậy. Gọi tới các ñồng nghiệp của anh ta, hỏi họ về công việc của anh ta trước ñó, ñặc 
biệt với bất cứ ñiều gì liên quan tới tính chất bảo mật dù chỉ là việc nhỏ. Nếu thích hợp cho tổ chức của bạn, 
bạn có thể xem xét từng bước với anh ta khi bước chân vào môi trường bảo mật của công ty.  

Kế tiếp, tạo ra các bước giúp hệ thông trung thực hơn nữa. Sử dụng các bảng ñăng nhập ñể nắm bắt xem ai 
vừa ở trong trạng thái quản trị. ða dạng hoá các thao tác quản trị với mức ñộ cao nhất có thể ñược, như một là 
làm tối thiểu hoá các tính năng mà mỗi nhà quản trị có ñược. Cũng như vậy, ñừng sử dụng account Admin, thay 
thế vào ñó ñưa cho mỗi nhà quản trị một account riêng biệt với quyến quản trị, vậy bạn có thể biết ñược ai 
ñang làm gì theo bảng tiến trình làm việc của anh ta. Bạn càng có nhiều nhà quản trị, bạn gần như càng có ít 
vấn ñề về bảo mật.  

Luật #7: Dữ liệu ñược mã hoá chỉ như chìa khoá giải mã  

Giả như bạn vài ñặt một hệ thống khoá lớn nhất, mạnh nhất, có ñộ bảo mật tốt nhất trên thế giới cho hệ thống 
của bạn, nhưng bạn phải ñặt mã ñể mở ñược hệ thống ñó. Nó sẽ thực sự là mạnh như thế nào, ñiều này còn 
phụ thuộc vào chìa khoá cho hệ thống khoá ñó. Nếu chìa khoá quá giản ñơn với hệ thống ñược bảo vệ, kẻ trộm 
có thể tìm ra nó. Vậy anh ta ñã có mọi thứ ñể mở cánh cửa ñó. Dữ liệu ñược mã hoá cũng chỉ an toàn như chìa 
khoá ñể giải mã nó.  

Rất nhiều hệ ñiều hành và các sản phẩm phần mềm về thuật toán mã hoá cho bạn một tuỳ chọn xem việc chứa 
các chìa khoá mã trên máy tính như thế nào. Thuận lợi của phương pháp này ñó chính là bạn không phải thao 
tác khoá bằng tay, nhưng có ñược ñiều này ñổng nghĩa với việc bạn phải trả một số tiền không nhỏ cho sản 
phẩm mã hoá. Các chìa khoá thường làm rối rắm và ñiều này thường rất tốt với hệ thống ñược mã hoá. Nhưng 
cuối cùng, nếu như mã ñó bị phát hiện, việc mã hoá này cũng trở nên vô tác dụng vì một người nào ñó vẫn có 
thể viết ra các chương trình bẻ khoá.  

Luật #8: Một hệ thống quét virus hết hạn thì cũng còn tốt hơn không có hệ thống diệt virus nào  

Các hệ thống quét virus làm việc ñược so sánh như hệ thống máy tính của bạn ñối chọi với một loại virus ñược 
ñăng kí. Mỗi một chữ kí là kí tự của một virus ñặc biệt, và khi hệ thống quét tìm dữ liệu trong một file, email, 
hay bất kì ñâu mà ñiền chữ kí. nó thông báo rằng ñã tìm thấy virus. Tuy nhiên, một hệ thống quét virus có thể 
chỉ quét cho các virus mà nó ñã biết. ðiều này thật cần thiết cho hệ thống của bạn ñược cập nhật thường xuyên 
hệ thống diệt virus vào mọi ngày.  

Phần mềm bảo vệ virus ảo cung cấp một cách nhận các chữ kí cập nhật miễn phí từ website của họ. Thực tế, 
rất nhiều phần mềm dạng này có  dịch vụ ñẩy thêm các cập nhật mới, mà họ sẽ gửi các thông báo khi cập nhật 
một virus mới. Những kẻ viết virus mới phát triển các kĩ thuật mới mà ñòi hỏi các hệ thống quét virus thay ñổi 
cách làm việc của chúng như thế nào.   

Luật #9: Tình trạng dấu tên hoàn toàn không thực tế  

Toàn bộ loài người ảnh hưởng lẫn nhau bao hàm việc trao ñổi dữ liệu về mọi mặt. Nếu một người nào ñó ñưa ra 
ñủ dữ liệu, họ có thể mô tả ñược bạn. Hãy nghĩ về toàn bộ thông tin mà một người có thể thu ñược chỉ trong 
một cuộc hội thoại ngắn với bạn. Chỉ một cái liếc mắt, họ có thể phán ñoán chiều cao, số cân, hay tuổi xấp xỉ 
mà bạn có. Giọng của bạn có thể nói cho họ biết rằng bạn từ ñâu ñến, và có thể thậm chí nói cho họ biết một 
vài ñiều về gia ñình bạn, sở thích của bạn, nơi bạn sống, và bạn ñang làm gì ñể kiếm sống. ðiều ñó không mất 
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nhiều thời gian cho bất kì ai muốn thu lượm thông tin ñể mô tả bạn là ai. Nếu bạn ao ước ñược giấu mặt hoàn 
toàn, cách tốt nhất là sống trong hang ñộng và tránh xa tiếp xúc với loài người.  

ðiều tương tự cũng ñúng với Internet. Nếu bạn thăm một website, người chủ có thể, nếu anh ta muốn biết bạn 
là ai. Cuối cùng, các con số 1 và các con số 0 mà tạo ra các phiên làm việc web có thể tìm ñược cách của chúng 
ñể ñến ñược ñúng nơi cần ñến, và ñó là máy tính của bạn. Có rất nhiều cách bạn có thể che dấu các bit, và bạn 
càng sử dụng chúng nhiều, các bit bạn sử dụng phải ñược che dấu nhiều hơn. Trong trường hợp, bạn có thể sử 
dụng ñịa chỉ mạng ñể che ñịa chỉ IP thật của bạn, sử dụng một thuê bao Internet  khác nhau cho các mục ñích 
khác nhau,... Toàn bộ ñiều này có thể làm cho bạn khó bị phát hiện hơn khi kiểm tra bạn là ai, nhưng không 
một cách nào có thể loại bỏ hoàn toàn các thông tin về bạn. Bạn có biết chắc chắn ai ñiều hành dịch vụ che dấu 
thông tin?, có thể ñó là một người nào ñó sở hữu website mà bạn vừa duyệt! hay website mà bạn mới ghé 
thăm hôm trước ñề xuất mail tới bạn một phiếu thưởng 10$? Có lẽ người chủ các trang web này sẽ hài lòng khi 
chia sẻ thông tin của bạn với một website khác. Nếu vậy, trang web thứ hai lại tiếp tục,... và sẽ kiểm tra ñược 
bạn là ai.  

Vậy ñiều ñó có nghĩa là chính sách trên web chính là nguyên nhân làm mất tính bảo mật? không phải hoàn toàn 
như vậy. Nó chỉ là phương cách tốt nhất ñể bảo vệ tính riêng tư của bạn khi truy cập Internet, cũng giống như 
bảo vệ bạn trong cuộc sống ñời thường theo cách xử sự của bạn. Hãy ñọc các lời mô tả về tính riêng tư trên các 
website khi bạn ghé thăm, và chỉ thực iện mua bán với một người nào ñó nếu thoả mãn các ñòi hỏi của bạn. 
Nếu bạn lo lắng về các cookies, hãy bỏ chúng ñi. Quan trọng hơn là nên tránh các website không có chứng 
thực, ñiều này cũng giống như trong hầu hết các thành phố ñều có những con ñường mà ta nên tránh ñi, 
Internet cũng làm như vậy. Nhưng nếu như bạn muốn không có ai biết về bạn, tốt hơn hết là tìm một hang 
ñộng ñể trú ngụ.  

Luật #10: Công nghệ không phải là tất cả  

Công nghệ có thể làm một vài ñiều gây kinh ngạc cho mọi người. Những năm gần ñây chúng ta ñã ñược nhìn 
thấy sự phát triển tột bậc trong cả phần cứng cũng như phần mềm như: phần cứng rẻ ñi và có nhiều tính năng 
mới, phần mềm cũng phát triển song song với phần cứng như tạo các tiêu chuẩn mới trong vấn ñề an toàn và 
bảo mật v các ngành khoa học khác liên quan tới máy tính. Nó mở ra viễn cảnh mà công nghệ có thể tạo ra một 
thế giới mới với tính năng an toàn bảo mật tuyệt ñối, nếu chúng ta làm việc chăm chỉ. Tuy nhiên, ñiều này là 
không thực tế.  

Bảo mật hoàn hảo ñòi hỏi phải có công nghệ hoàn hảo tương ứng, ñiều này không tồn tại, và thực tế chưa bao 
giờ tồn tại. Việc phát triển phần mềm là một ngành khoa học không chính xác, và toàn bộ các phần mềm ñều 
có lỗi. Một số có thể do sử dụng quá tải dẫn ñến không an toàn bảo mật. Nhưng thực tế với ngay cả phần mềm 
ñược lập trình hoàn hảo, nó cũng vẫn không giải quyết ñược toàn bộ các vấn ñề. Hầu hết các các tấn công bao 
gồm nhiều cấp, từ mức này tới mức khác. Việc tăng giá thành và ñộ khó trong công nghệ về an toàn bảo mật, 
và kẻ xâm phạm hệ thống sẽ tìm cách phá hoại hệ thống này theo cách khác, như về con người chẳng hạn. Bạn 
có thể duy trì ñược hệ thống bảo mật của bạn tốt hơn nữa hay bạn lại trở thành nguyên nhân gây ra lỗi cho hệ 
thống.  

Giải pháp là thừa nhận hai ñiểm mang tính bản chất. ðiểm thứ nhất, an toàn bảo mật bao gồm cả công nghệ và 
chính sách, có nghĩa là, nó kết hợp công nghệ và hệ thống của bạn an toàn ñến ñâu với các vấn ñề thuộc bản 
chất. ðiểm thứ hai, an toàn bảo mật là một quá trình, không có kết thúc, nó không phải là một vấn ñề mà có 
thể giải quyết một lần cho tất cả; nó là một tập các vấn ñề luôn tồn tại và các biện pháp giữa người mang tính 
bảo vệ và người mang tính phá hoại. Chìa khoá ñể ñảm bảo rằng bạn có một hệ thống bảo mật tốt ñó phụ 
thuộc chính vào yếu tố con người và các chính sách của 
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